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1.0 Introduction 
Available free-of-charge, the Electronic Shipping Tools (EST) application provides greater convenience in preparing and processing 
Manifests for mailing with Canada Post. Customers download the version of the Electronic Shipping tools to prepare items and 
documentation offline to be transmitted later.  The Electronic Shipping Tools offers enhanced features and will reduce paperwork, 
save time, and improve billing/transaction accuracy. 
 
A sample screen shot follows each main Window for visual reference purposes. The Electronic Shipping Tools is dynamic: the 
appearance will differ depending on the display settings in your Windows operating system. 
 
When you successfully transmit an electronic order and apply a bar coded shipping label to your items, you are entitled to the 
automation incentive, which is 3%.  It applies to Shipping and Delivery Services shipments both within Canada and Internationally.  
This automation incentive is only available to customers that use their own computer equipment along with Electronic Shipping 
Tools. 
 
A pop-up message indicates the savings you receive as a result of the Automation discount.  
 
Please note that the automation incentive does not apply to options (for instance, C.O.D. and Delivery Confirmation, etc.) and is 
applied before taxes and fuel surcharge. 
 
For more details on any aspect of the application, contact the Electronic Shipping Tools Help Desk weekdays from 7:00 am to 8:00 
pm (Eastern Standard Time) at 1-800-277-4799.  For more details about Canada Post products and services, please visit the 
Canada Post website at www.canadapost.ca, see the Canada Postal Guide, or contact your Canada Post Sales Representative. 

New Connection on Start-up 
 
The Desktop version of Electronic Shipping Tools (EST) is based on highly synchronized data related to your contract with Canada 
Post.  In order to ensure your mailings and your invoices matches, it’s important that you keep your Desktop application up to date. 
 
To help ensure you receive all the updates you need to keep your Desktop version current, the Communication Status Notification 
page requires that you establish a daily connection with the EST server before creating Statements of Mailing (SOMs) or Manifests. 
 
You will be connected to the EST server the first time you launch the application each day; the server will then automatically check 
for and apply any updates.  If, for any reason, a connection cannot be established with the EST server, you will see an error 
message indicating your connection failed.  When you click on the OK button, start up will continue. 
 
All other aspects of connecting to the EST server remain unchanged.  When you check for updates during the day under Check for 
Application, Data and Barcode Update, the Desktop will continue as before, checking for application and data updates during the 
Transmit process.  Note that if the connection at start-up was successful, there should not be any additional updates available. 

Navigating Around Electronic Shipping Tools Desktop Application 
 
To select from the Main Menu or to activate a command button: 

• Use the mouse to point and click on the desired option. 
• Use hot keys as defined by an underlined letter or indicated between <>. 

 
To move from field to field: 

• Use <TAB> or your mouse to move from one field to the next or point and click with the mouse. 
• Use the left and right arrow keys to move between choices for a single field (e.g. radio buttons).  Click on your choice to 

select it. 
 
As you move from field to field, the application performs validation on the data type and format.  You must acknowledge the 
message and make the necessary correction to the field in order to continue with the entry of data. 
 
Click on the down arrow to display a selection/drop-down list.  All drop-down lists have the same functionality.  That is, if the user 
types a character, then the drop-down list automatically scrolls to the first item in the list that begins with this character.  If the user 
types a second character, then the list automatically scrolls to the first item that begins with both characters entered.  For example: 
 

User Types… List Scrolls To… 
1. A Afghanistan 
2. N Andorra 
3. G Angola 
4. U Anguilla 
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However, once the first character is typed, the user cannot make the application scroll to an item in the drop-down list that begins 
with a different character by typing in that other character.  For example, if the user types a “T”, the drop-down list automatically 
scrolls to the first item that begins with “T”.  From this point on, the application considers only those items that begin with “T”.  If the 
user types a “H”, then the list automatically scrolls to the first item that begins with “TH”, not the first item that begins with “H”. 
 
The Help section of the application will provide a description of fields and command buttons for each window. 
 
Sorting:  For all lists with data displayed in columns, you can click on the desired column heading to have the data automatically 
sorted by that field. 

2.0 Electronic Shipping Tools Desktop Window 
The application Desktop window for the electronic Statement of Mailing (SOM) acts as the control centre for all your processing of 
Order transactions.  From this window, you can manage and navigate through the application structure, select Orders to transmit to 
CPC, print/reprint Order documents, delete Orders and initiate the data capture of new Orders or complete data capture for partially 
entered Orders. 
 
The desktop also provides a visual representation of how the Orders, Order templates and the Transmit Session Logs are 
organized.  The window is of a multiple windowpane design.  You will find in this section a definition and a description of the fields in 
each of the panes, and a definition of each of the command buttons. 
  

 

 2.1 Main Menu 
 
The Main Menu of the desktop window consists of the following menus, which will be described in greater detail in subsequent 
chapters: 
 

� File Menu– This menu allows you to either create a new Manifest, or close the Shipping Window (for further details, 
please see chapter 3) 

� Customer Menu– This menu displays the Mailed On Behalf Of customer names, along with their numbers, that are 
configured on your Electronic Shipping Tools desktop application (for more details, please see chapter 4) 

� Security Menu - Use this menu to add and delete Electronic Shipping Tools users, and determine the Electronic Shipping 
Tools functions they are allowed to access (for further details, please see chapter 5) 

List Pane 

Details Pane 

Folder Pane 

Title Pane 

Main Menu

 Command Buttons 
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� Data Maintenance Menu- Use the Data Maintenance menu to manage your customer data and site information.  You can 
also configure many aspects of Electronic Shipping Tools from this menu, along with assigning aliases (i.e. meaningful 
names) to contracts and cost centers (for further details, please see chapter 6) 

� Reports Menu - Use this menu to access the Reports and Delivery Confirmation functions (for further details, please see 
chapter 7) 

� Tools Menu - Use this menu to perform system functions and configure peripheral equipment used with Electronic 
Shipping Tools as follows (for further details, please see chapter 8) 

� Window Menu - Use this menu to select from the open windows on the Electronic Shipping Tools application 
� Help Menu – Provides you with the tools required for completion of orders (for further details, please see chapter 10) 

2.2 Folder Pane 
 
  Opened Manifests 
 
Once a manifest is created (either manually via File > New Manifest or automatically via the processing of a transaction), it has the 
status of Open.  The application assigns to it an EST ID.  EST ID’s are generated in numerical sequence, starting at 1, and are 
unique per application desktop.  A line item representing the manifest is created in this folder.  An Open manifest continues to 
accumulate transactions. 
 
Click on an Open manifest to display the details of all of its shipments to date in the bottom frame.  This enables the Open, Finalize, 
Transmit/Print, Move, and Delete buttons. 
 
Double-click on an Open manifest to have its information displayed in the Manifest window with the EST ID indicated in the top bar. 
  
ATTENTION!  Manifests are created per Mailed On Behalf Of customer number (i.e. you can have the same manifest type open 

for different customer numbers) and Method of Payment for each customer number (i.e. for one customer number, you can 
have the same manifest type open for different methods of payment). 

 
  Finalized Manifests 
 
When you finalize a manifest (by clicking the Finalize button on either the Application Desktop window or Search/Manage Orders 
window), no more transactions are posted to it. 
 
If you decide that you want to post more transactions to the manifest or void an existing transaction on it, you can change its status 
back to Open by moving it to the Opened Manifests folder. 
 
Click on a Finalized manifest to display the details of all of its shipments in the bottom frame.  This enables the Open, 
Transmit/Print, Move, and Delete buttons at the bottom of the page. 
 
Double-click on a Finalized manifest to have its information displayed in the Manifest window with the EST ID indicated in the top 
bar. 
 
  Transmitted Manifests 
 
When you transmit a manifest (by clicking the Transmit/Print button on either the Application Desktop window or Search/Manage 
Orders window), the manifest information is sent to the CPC server.  Afterwards, no changes can be made to the manifest, such as 
voiding transactions on it. 
 
Click on a Transmitted manifest to display the details of all of its shipments in the bottom frame.  This enables the Open, Reprint, 
Move, and Delete buttons at the bottom of the page. 
 
Double-click on a Transmitted manifest to have its information displayed in the Manifest window with the Local ID indicated in the 
top bar. 
 
  Finalize Session Logs 
 
When you finalize a manifest, some validations are performed (e.g. validation of credit card information).  If an error occurs, a 
session log documenting the error is created in this folder.  If the validations are successful, NO log is created. 
 
Click on a Finalize session log to display its details in the bottom frame.  This enables the Open, Move, and Delete buttons at the 
bottom of the page. 
 
Double-click on a Finalize session log to have the same information displayed in the Reports window so that it can be printed. 
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Transmit Session Logs 
 
When you transmit a manifest, validations are performed and a connection to the CPC server is initiated.  If an error occurs as part 
of the finalizing process, a session log documenting the error is created in the Finalize Session Logs folder.  If an error occurs 
AFTER this process or the validations are successful, a session log, indicating success or error, is created in the Transmit Session 
Logs folder. 
 
Click on a Transmit session log to display its details in the bottom frame.  This enables the Open, Move, and Delete buttons at the 
bottom of the page. 
Double-click on a Transmit session log to have the same information displayed in the Reports window so that it can be printed. 
 
  Deleted Manifests 
 
You can delete a manifest of any status.  Click on a Deleted manifest to display its details in the bottom frame.  This enables the 
Move and Delete buttons at the bottom of the page.  Double-click on it to have its information displayed in the Manifest window with 
the Local ID indicated in the top bar. 
 
ATTENTION!  Whether Canada Post picks up your items or your deposit them at a postal installation, including Revenue 

Verification Unit (RVU), a manifest must accompanied the shipment to avoid the risk of refusal.  A printed copy of the 
manifest preview is unacceptable.   

 
  Deleted Logs 
 
You can delete a log of any type.  Click on a Deleted Log to display its details in the bottom frame.  This enables the Move and 
Delete buttons.  Double-click on it to have the same information displayed in the Reports window so that it can be printed. 

2.3 List Pane 
 

Application Desktop Window – Top Frame:  List of Manifests 
FIELD NAME FIELD CHARACTERISTICS 

Manifest Number This field display a generated number assigned to the manifest. 
Manifest Type This field identifies the Manifest selections based on the 

Contract selected. 
Mailed On Behalf Of Customer This field identifies the CPC assigned customer number of the 

customer who owns the mailing (i.e., customer on behalf of 
whom the mailing is being prepared). 

Contract Number This field identifies the contract number used for the mailing.  
The contract has an influence on the rates applied to the 
mailing. 

Paid-by Customer Number This field identifies the CPC assigned customer number of the 
customer who is paying for the mailing 

Method of Payment This field indicates the customer’s chosen method of payment 
for the mailing. 

EST ID This field display a generated number assigned to the manifest. 
Date/Time This field displays the date and time the manifest was created. 
Mailing Date This field displays the date when the mailing is to be inducted at 

Canada Post. The date of mailing has an influence on the 
calculation rules. 

Prepaid Count This field displays the number of shipment items that have been 
prepaid. 

Status This field displays the status (e.g., transmitted) of the order. 
Attempted Communication Date This field displays a date when a communication with CPC 

server was attempted. 
GST Amount This field displays the amount of GST (Goods and Services Tax) 

associated with the Manifest in question. 
PST Amount This field displays the amount of PST (Provincial Sales Tax) 

associated with the Manifest in question 
HST Amount This field displays the amount of HST (Harmonized Sales Tax) 

associated with the Manifest in question 
Customer Reference This field displays the reference number as assigned by the 

customer. 
Manifest Name This field indicates the user-entered name for the manifest. 
Destination Postal Code This field displays the destination postal code for Air Stage 

Freight. This field is disabled for other products. 
Outlet Name This field displays the induction point of the Manifest. 



 

©June2005 Canada Post Corporation  5 

 

2.4 Details Pane 
 

Application Desktop Window – Bottom Frame:  List of Transactions per Manifest 
FIELD NAME FIELD CHARACTERISTICS 

Item Number This field displays the number associated with this item on the 
manifest. 

Voided This field indicates if the order is valid or void. 
Order  ID This field displays a unique number that identifies the shipment 
First Name This field displays the first name of the customer associated with 

this item. 
Last Name This field displays the last name of the customer associated with 

this item. 
Company Name This field displays the company name of the customer 

associated with this item. 
Item Weight This field displays the weight of the item. 
Cubed Weight This field displays the cubed weight of the item. 
Length This field displays the length of the item. 
Width This field displays the width of the item. 
Height This field displays the height of the item. 
Service Type This field displays the Distribution service in question. 
Signature Indicator This field displays whether or not the Signature option was 

selected for the item. 
Delivery Confirmation This field displays whether or not the Delivery Confirmation 

option was selected for the item. 
 Coverage Indicator This field displays whether or not the Insurance option was 

selected for the item. 
Insured Value This field identifies the amount for which the item is being 

insured. 
COD Indicator This field displays whether or not the COD option was selected 

for the item. 
COD Value This field identifies the amount of the COD.  
COD Method of Collection This field displays the method of collecting the COD amount. 

Cash 
Cash or Cheque 
Post-dated Cheque 

COD Collection Amount This field identifies the amount collected upon delivery. 
Oversize Indicator This field displays whether or not the Oversize option was 

selected for the item. 
Proof of Age Required (18) This field displays whether or not the Proof of Age Required (18) 

option was selected for the item. 
Proof of Age Required (19) This field displays whether or not the Proof of Age Required (19) 

option was selected for the item. 
Card for Pick Up This field displays whether or not the Card for Pick Up option 

was selected for the item. 
Not Safe for Drop This field displays whether or not the Not Safe for Drop option 

was selected for the item. 
Special Delivery Indicator This field displays whether or not the Special Delivery option 

was selected for the item. 
Registered Indicator This field displays whether or not the Registered option was 

selected for the item. 
Acknowledgement of Receipt Indicator This field displays whether or not the Acknowledgement of 

Receipt option was selected for the item. 
Evening Delivery (6 p.m. – 9 p.m.) This field displays whether or not the Evening Delivery option 

was selected for the item. 
Saturday Delivery (9 a.m. – 1 p.m.) This field displays whether or not the Saturday Delivery option 

was selected for the item. 
Pick Up @ Post Office This field displays whether or not the Pick Up @ Post Office 

option was selected for the item. 
Deliver to Door This field displays whether or not the Deliver to Door option was 

selected for the item. 
Deliver to Parcel Box This field displays whether or not the Deliver to Parcel Box 

option was selected for the item. 
Item Pretax Amount This field identifies the pretax amount associated with the item. 
Item GST Amount This field identifies the GST amount associated with the item. 
Item HST Amount This field identifies the HST amount associated with the item. 
Item PST Amount This field identifies the PST amount associated with the item. 
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Province/State This field identifies the destination province. 
Country This field identifies the destination country. 
Postal/Zip Code This field identifies the destination postal /zip code. 
Item Ref #2 This field is for customer reference only and is optional. 
Return Label This field displays whether or not there is a Return Label on the 

item. 
Return Item Number If the Return Label field is checked for the item, this field will 

identify the Return Item Number associated with it. 

2.5 Command Buttons 
 
ATTENTION!  These command buttons apply ONLY on the manifest line items, NOT on the individual transaction line items of each  
Manifest.  For example, you CANNOT move a transaction line item from one manifest to another or delete a transaction from a  
Manifest. 
 
All the command buttons you need to do a mailing are in one place, grouped in five different categories on this Desktop page.  
Some commands, designated here with a * can also be found from the toolbar.  
 
Shipping: 
 
 
 
(Shipping and Delivery Services)  This button allows you to prepare and ship a package* 
 
 
 
(Shipping and Delivery Services)  This button allows you to track a package*   
 
 
 
This button allows you to void an item (shipment) 
 
Mailing: 
 
 
 
(Communication Services)  This button opens a pop-up menu, which will determine the type of SOM you will create based on the 
type of service you select. 
 
 
 
 
This button allows you to generate reports that will help you reconcile your shipping business. 
 
Documents: 
 
 
 
To transmit either an Open or Finalized manifest, click on its line item to select it and click this button.  A connection to the CPC 
server is initiated and validations are performed.  If an error occurs, a session log documenting the error is created either in the 
Finalize Session Logs folder or Transmit Session Logs folder.  If there are no errors, the manifest information is sent.  The 
application also prints the manifest. 
 
You must supply a printed Manifest to the Canada Post agent with your shipment.  Otherwise, your shipments run the risk 
of being refused. 
 
Note:  If the transmission fails, the application prints a manifest with a “Non-Transmitted” watermark on each page.  Attach this 

printed copy to your shipment and retransmit the manifest later. 
 
ATTENTION!  Regarding manifests that fail on Transmit, Canada Post currently allows a grace period of 12 days during which they 

can remain un-transmitted.  This grace period is under the control of Canada Post.  Once this grace period is over, you are 

Ship a Package 

Track a Package 

Void an Item 

Create a SOM 

Print a Report 

Transmit/Print 
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locked out of the application and thus forced to connect to the CPC server to transmit these manifests.  This happens after you 
click on the Desktop icon.  The Communication Status Notification window appears, on which you need to click Connect. 

 
 
 
To finalize an Open manifest, click on its line item to select it and click this button.  The application automatically moves the line item 
from the Opened Manifests folder to the Finalized Manifests folder.  Some validations are performed, such as the validation of 
credit card information.  If an error occurs, a session log documenting the error is created in the Finalize Session Logs folder. 
 
 
 
You can only reprint Transmitted manifests.  To do so, click on its line item to select it and click this button.  The printed copy has a 
“Reprint” watermark on each page. 
 
 
 
You can change the status of a manifest by moving it to a different folder.  However, from a particular folder, the application dictates 
to which other folders a manifest can be moved.  You can also move a Finalize or Transmit session log between its folder and the 
Deleted Logs folder. 
 
To move a line item, click on it to select it and click this button.  The Move Items pop-up window (see below) appears.  The 
permissible destination folders, along with the source folder, are displayed.  Click on the desired folder (it becomes bolded) and click 
OK.  To end the action, click Cancel. 
 

 
 
You can also perform the Move functionality by clicking on a line item to highlight it and selecting Move from the File menu. 
 
Refer to the following table for permissible destination folders. 
 

FROM FOLDER TO FOLDER 
1. Opened Manifests Deleted Manifests 
2. Finalized Manifests Deleted Manifests, Opened Manifests 
3. Transmitted Manifests Deleted Manifests 
4. Finalize Session Logs Deleted Logs 
5. Transmit Session Logs Deleted Logs 
6. Deleted Manifests Opened Manifests (previously Open AND Finalized manifests), Transmitted Manifests 

(previously Transmitted manifests) 
7. Deleted Logs Finalize Session Logs (previously Finalize logs), Transmit Session Logs (previously 

Transmit logs) 
 
 
 
To delete a manifest or a log, click on its line item to select it and click this button.  If you do this in any folder except for the Deleted 
Manifests and Deleted Logs folders, NO confirmation message appears.  The application automatically moves the line item from 
the folder to the appropriate Deleted folder.  If you do this in the two aforementioned folders, a confirmation message appears.  Click 
OK to permanently delete the line item from the application.  Click on Cancel to keep the line item in the Deleted folder. 
 
You can also “delete” a line item via the Move button to move it to the appropriate Deleted folder or by selecting Delete from the File 
menu. 

Finalize/On Hold 

Reprint 

Move 

Delete 
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To open a manifest of any status or a log of any type to see and print its information, click on its line item to select it and click this 
button.  For a manifest, the Manifest window appears with the Local ID indicated in the top bar.  For a log, the Reports window 
appears. 
You can also open a manifest or log by double-clicking on its line item or clicking on it to highlight it and selecting Open from the 
File menu. 
 
Tables: 
 
 
 
 (Shipping and Delivery Services)  This button allows you to create an address book, add/delete recipients to and from the address 
book, and edit address book entries * 
 
 
 
(Shipping and Delivery Services)  This button allows you to import order entry information produced outside the Electronic Shipping 
Tools into the application database * 
 
 
 
This button allows you to export order history  
 
System: 
 
 
 
This button opens a pop-up window containing the tools you need to complete an order.  Click here for more details 
 
 
 
This button allows you to query if any updates are available*  
 
 
 
Clicking this button closes all application windows and exits the desktop application.  If you were creating or editing a manifest in the 
Manifest window, a message appears asking if you want to save your changes.  However, if certain windows are open, such as the 
Client window, this functionality does not work and the application emits a beep to inform you to close these windows first. 
 
You can also exit the application by selecting Exit from the File menu * 
 
ATTENTION!  If you have entered data for a transaction on the Shipping window, clicking Exit will NOT prompt you to save your 
data or automatically save it for when the application is next launched 

  

Open 

Address Book 

Import Order File 

Export History 

Help 

Check for Updates 

Exit 
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2.6 Popup Menus 
 
Popup menus appear within the applicable windowpane when you right click the mouse on items located in the Folder and List 
Panes. 
 

POPUP MENU ITEM RESULT OF INVOCATION 

Folder Pane Popup Menu 
Create Folder • A folder has been selected from the Folder Pane. 

• Opens the Create Folder dialogue window. 
Rename • A user-created folder has been selected from the Folder Pane. 

• Highlights the name of the selected folder, and allows you to change its name. 
Expand • Expands the folder structure. 
Collapse • Collapses the folder structure. 
List Pane Popup Menu 
Open • If a Manifest has been selected:  Opens the Manifest window for the selected Manifest. 

• If a Transmit Session Log record has been selected:  Displays the Transmit Session Log record in the 
Report Preview window. 

Delete • Deletes the selected entries.  When the current folder is any folder other than the Deleted SOMs or 
Deleted Logs folder, this action moves the selected items to the Deleted SOMs/Logs folder.  No 
confirmation is requested. 

• If the current folder is the Deleted Manifests or Deleted Logs folder, this action physically deletes the 
selected item(s) from the application database.  You are requested to provide confirmation. 

Move • Displays the Move Item(s) window to allow you to select the destination folder to which the selected 
items are to be moved.  Click here to find more details in chapter 2.5 – Command Buttons. 

 

2.7 Managing Communication with CPC Server 
 
During the following processes, the application manages communication and the data synchronization between your system and the 
CPC server: 
 

• Checks for reference data, barcode range and software application updates (from the Tools menu select Check for 
Application, Data and Barcode Update); 

• Transmit/Print orders to the CPC server. 
 
During either of these two processes, the application established communication with the CPC server to ensure you have the most 
current rates and the latest version of the application. 
 
Associated with the tasks above, the following steps are performed: 

• You will see the status bar with the progress of each updated process; 
• A connection established with the CPC server, if a connection does not already exist; 
• Prompts for you to logon to the CPC server; 
• Initiates updates, verification and availability of reference data, barcode replacement and software application 

updates; 
• A Transmit Session Log is maintained for communications with the server; 
• Prints the orders that have been successfully transmitted. 

 
Transmit Session Log 
 
A Transmit Session Log is maintained for messages returned from the Transmit/Print server process.  The following window is 
displayed when a single order transmit has failed or all orders during a multiple order transmit return with errors.  
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Transmission Session Log 
COMPONENT DESCRIPTION 

Transmit Session 
Identifier 

The file name of the log file. 

Transmit Session Date The date and time of the transmit session. 

Application Version The current version of the application. 

Electronic Shipping 
Tools Transmit Session 

A message returned by the CPC server.  This message space is used: 
• To document that a successful transmit session has been achieved, or 
• To document that transmit session could not be established and the reason for the 

session failure.  This message will also include instructions the user is to follow to 
correct the problem. 

Manifest/SOM Local 
Identifier 

The local system identifier of the SOM being transmitted. 

Server Manifest / SOM 
Id 

The SOM Id assigned by the CPC server.  This will be blank if an error condition exists with the 
current SOM being transmitted. 

Acknowledgement 
Message 

A message returned by the CPC server.  The message space is used: 
• To document the successful transmit of the local SOM or 
• To document that the local SOM has not been successfully transmitted and the 

reason(s) why.  If the server detects an error with the SOM being transmitted, the server 
will return one or more error messages describing the errors it has identified.  

Transmit Status 
Message 

This message identifies the number of SOMs successfully transmitted during this session. 

2.8 Logon to the CPC Electronic Shipping Tools Server 
 
This Window allows you to logon on the Electronic Shipping Tools CPC server to:  

• Transmit orders to the CPC Server; 
• Initiate an application and reference data update; or 
• Obtain delivery confirmation status on one or more manifest items (Shipping and Delivery Services only). 

 
It is triggered the first time you initiate one of the server processes above during the current session.  The User Id and Password is 
remembered for the remainder of the current session after the first successful connection to the CPC server and reuses the logon 
information for the subsequent connection to the server. 
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3.0 File Menu (Shipping Window) 

 
 
Access this window by either selecting New Shipment from the File menu, or clicking on the Ship a Package command button.   

 
Default Setting 
 
For a particular Mailed On Behalf Of customer number, you can set the Shipping window to automatically open on startup.  
Select Site Information from the Data Maintenance menu.  Choose the Default Settings tab, then the Shipping tab.  Select 
the Open Shipping Window on Startup checkbox. 

 
Use this Shipping window to enter all shipping transactions in Electronic Shipping Tools.  See details for the four sections of this 
window (Ship To, Parcel Information, Service and Options, and Charge To Information) in the subsequent chapters below. 
 

Navigation Menu 

Command Buttons 
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To avoid duplicate data entry, “reusable data” is kept from item to item while item-specific data, such as the client and weight, is 
cleared once an item is processed.  If some reusable data does not apply to the current shipment, change it and the new value(s) 
will start applying to all shipments from that point on.  

Shipping Steps 
 
The following table presents the steps of the shipping process.  Details regarding the Shipping window, Credit Card Data Entry, and 
Customs – as well as the Rate Shop window, are provided in the following sections.  The layout of the shipping window allows you 
to review all information entered to ship a parcel from one page. 
 

DESKTOP SHIPPING PROCESS FLOW 
SHIPPING TASK TASK COMPONENTS & CHARACTERISTICS 

1. Open Blank Shipping Window Either select New Shipment from the File menu, or click on the Ship a Package 
command button.  Shipping window opens. 

2. Assess Payment Information If necessary, select the Charge To command button to assess payment information 
(e.g. Mailed On Behalf Of customer number, Method of Payment).  Make desired 
changes. 

3. Enter/Retrieve Client 
Information 

In the Ship To section: 
1. Enter manually client information. 

OR 
2. Retrieve client information via search on Client ID, Order ID / Reference #1, 

Last Name, or Company. 
OR 

3. Retrieve client information using a Group Shipping List of Clients or a 
Group Shipping List of Imported Orders. 

 
Note:  If an imported order item contains a Client ID that exists in an address book 

and all mandatory client address data BUT this data is different from that in the 
address book, the data from the imported order item overrides the data in the 
address book when you search on Order ID / Reference #1. 
 
However, if the imported order item is missing even one mandatory address 
data value (e.g. the city), the address book data is fetched. 

 
Choose to print the address label, provide only enough information for 
Quickship, and/or print the customs document by selecting the appropriate 
checkbox. 

 
• To print the Quickship label, BOTH the Print Address Label and Quickship 

checkboxes must be selected. 
• For the Customs button to become enabled, BOTH the Country on the 

Ship tab and Service Type on the Service tab must be selected. 
 
ATTENTION!  If you select the Print Address Label checkbox on the Ship To 

section, and then change the Service Type (this includes populating a blank 
Service Type field) on the Service and Options section, the Print Address Label 
checkbox will be refreshed. 

   
If desired, select a Cost Centre. 

4. Enter/Retrieve Parcel 
Information 

Enter shipment information in the Parcel Information section.  You can manually 
enter this information or select a predefined container from the Container drop-
down list.  Weight is the only mandatory field. 

5. Enter Service and Options Select a Service Type and add options related to this service. 
 

Note: If a Manifest already exists for the Service Type chosen, its name (i.e. 
date and time of creation) populates the Manifest field (display-only).  If more 
than one Manifest exist for that Service Type, they are displayed in the 
Manifest drop-down list.  Choose the appropriate one. 

6. Rate Shop Select the Rate Shop button to initiate rating for the item by the local pricing 
engine. 
 
This populates the Service Std, Weight, and different cost fields in the Calculate 
preview  window. 

7. Enter Customs Information 
(USA and International only) 

The Customs button becomes enabled when the Print Customs Document 
checkbox and Country, outside of Canada, in the Ship To section and Service Type 
on the Service and Options section have been selected. 
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The data entry fields on the Customs window will incorporate the mandatory 
information on the correct customs document. 
 

Note:  Customs information is mandatory for Purolator Intl PuroLetter, 
Purolator Intl PuroPak, Purolator International, and Commercial* Expedited 
Parcel – USA.  You will need to supply this information EVEN if the Print 
Customs Document checkbox is not selected. 

8. Calculate   This button allows you to review parcel, cost and barcode information. 
9. Process/Print Transaction Click the Process/Print button.  This posts the transaction to the appropriate 

manifest.  If the options have been selected, the address label(s) and proper 
customs document are printed. 

10. End of Day Click the End of day button when you finalize a manifest, no more transactions are 
posted to it. 
 
If a validation performed at this stage fails, a session log documenting the error is 
created in the Finalize Session Logs folder on the Application Desktop window. 
 

• On the Search/Manage Orders window, you MUST finalize the manifest 
first before being allowed to transmit it to CPC. 

• The benefit of finalizing a manifest first is that you can change its status 
back to Open so that you can void a transaction. 

 
This initiates a connection with and sends your manifest information to the CPC 
server.  It also creates a session log, indicating success or error, in the Transmit 
Session Logs folder on the Application Desktop window. 
 
If a validation performed at the Finalize stage fails, you can find the session log 
documenting the error in the Finalize Session Logs folder on the Application 
Desktop window.  If a validation fails after this stage, the error is documented in the 
session log in the Transmit Session Logs folder. 

 
Note:  All items, except prepaid products, must be accompanied by a Manifest, unless the customer uses a Bill of Lading  
or, the On-line version of the Electronic Shipping Tools. 

Shipping Window Components 

3.1 Navigation Menu 
 
 
 
The Navigation Bar of the shipping page consists of the following menus: 
 

� File – This menu allows you to either create a new Manifest, or close the Shipping Window  
� Data Maintenance - Use the Data Maintenance menu to manage your customer data and site information.  You can also 

configure many aspects of Electronic Shipping Tools from this menu, along with assigning aliases (i.e. meaningful names) 
to contracts and cost centers  

� Shipping Preferences – Contains data from the Default Settings tab of the Site Information page  
� Track a Package -   (Shipping and Delivery Services) This menu allows you to search for an item by Item number or 

Delivery Notification Card number  
� EST Desktop – Redirects you to the Desktop main page  
� Help  – Provides you with the tools required for completion of orders  

3.2 Command Buttons 
 
 
 
This button displays the Charge To Information pop-up page (below). Information entered here will automatically appear on the 
shipping page under the Charge To Information section. 
 

Charge To 
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This button is enabled only if the destination Country is Canada.  Click this button to access the Rate Shopper window (seen 
below), where you can compare the costs of sending your shipment using different Canada Post Shipping and Delivery Services 
domestic products. 
 

 
 
You can change the selection of options to see the impact on pricing.  Select the checkbox beside an option to include the cost for it 
in the Total reflected at the bottom of each product column.  For the Additional Coverage option, indicate the amount of insurance 
coverage required.  Once you have selected all required options, click Apply to recalculate the costs.  The applicable taxes (PST, 
GST, or HST) and Total cost are shown for each product. 
 
Click the Calculate button to initiate the recalculation of the option costs, taxes, and total price for each service so that you can see 
the impact of changing the option selections. 
 
Click the Apply button to populate the Service and Options section with the information from the selected Service Type in the Rate 
Shopper window.  To select a Service Type, click anywhere in its column BELOW the column heading (the column turns purple).  
This button also closes the window. 
 
Click the Cancel button to close the Rate Shopper window. 
 
 
 
 
BOTH the Country on the Ship To section and Service Type on the Service and Options section must be selected to enable  
the Customs button.  Since customs information is mandatory for Purolator Intl PuroLetter, Purolator Intl PuroPak, Purolator  
International, and Commercial* Expedited Parcel - USA, this is all that is required to access the Customs window. 

 
Click here for further information on the Customs process. 
 

Rate Shop <F3> 

Customs <F10> 
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This button becomes enabled when all mandatory fields have been entered.  Click this button to send the shipment for rating by the 
local pricing engine.  A Calculate Preview pop-up page will be displayed, including Parcel, Cost, Service Std, and Barcode 
information.  Certain validations (e.g. Postal Code) are performed.  These fields are read-mode only.  
 

 
 
ATTENTION!  If you change the Service Type in the Service and Options section, you need to click Calculate again to update the 

different cost fields. 
 
 
 
 
Click the Process/Print button once you have completed all mandatory fields on the Shipping window, and are ready to post the 
transaction to the appropriate manifest.  Electronic Shipping Tools checks if all mandatory fields are completed, and warns you if 
they are not.  Other validations are performed, such as checking for acceptable parcel measurements.  If the options have been 
selected, the address label(s) and proper customs document is printed. 
 
If a manifest does not already exist for the Service Type selected, the application will automatically create one.  The Manifest field 
in the Charge To Information section becomes populated with the manifest name (i.e. date and time of creation), along with its 
Local ID. 
 
You remain in the Shipping window so that you can enter the next transaction. 
 
 
 
 
Clicking on this button displays the End of Day pop-up page, enabling you to transmit the last successfully processed transaction if 
the related manifest is still open.  This page allows you to transmit the manifest without navigating back to the Desktop main page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click this button to close the Shipping window. 
 

Calculate <F4> 

Close 

End of Day 

Process/Print 
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ATTENTION!  If there is currently data on the window for a shipment that has not been processed yet, clicking Close does NOT 
prompt you to save the data/process the transaction or automatically save the data for when the application is next launched. 

3.3 Ship To Section 
 
The Ship To section of the shipping page contains information related to the recipient and the functions like: Import Order ID, Print 
Return Label, Print Customs Document, Print Address Label, Void Items, E-Mail Notification, Add Client, and Group Shipping.   
 
It also contains checkboxes for the following functions:  Quickship, Print Return Label, Print Customs Document and Print Address 
Label. 
 
You may use two reference fields to record additional information pertaining the shipment. 
 
The E-Mail field lets you choose several options for e-mail notification:  Client #1, mailed By, Behalf of, and/or E-Mail #2 

 
 
 
 
ATTENTION!  Even though the Address field is not marked with an asterisk to indicate that it is mandatory, it is a required value.  

Validation occurs when you click the Process/Print button. 
 

Ship To Section 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Print Address Label Select this checkbox if you want to print the address label(s) for the current shipment (if 
any are produced).  If you select the Print Address Label checkbox in the Ship To section 
and then change the Service Type (this includes populating a blank Service Type field) in 
the Service section, the Print Address Label checkbox will be deselected. 

Print Return Label Indicates whether the customer wants to print a Return Label for selected package. 
Print Customs Document This checkbox is enabled ONLY for a US or International destination. 
Client ID A user-determined number that identifies the client (i.e. recipient of the shipment).  This 

number can be any combination of digits and/or letters.  You can retrieve client address 
data via a search on this field. 
 
Note:  The application does not prevent duplicate Client ID’s from being supplied. 

Order ID / Reference #1 A user-determined number that identifies the shipment.  You can retrieve client address 
data (be aware that it may be incomplete) via a search on this field. 
 
Note:  The application does not prevent duplicate Order ID / Reference #1 ‘s from being 

supplied. 
Quickship Select this checkbox if you want to provide only enough client address information for a 

Quickship shipment (because your address labels have been produced using other 
means).  For further information, please refer to the Quickship Overview section at the end 
of this chapter. 

Title From the drop-down list, select an appropriate salutation for the recipient. 
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First Name Enter the first name of the recipient. 
Last Name Enter the last name of the recipient.  You can retrieve client address data via a search on 

this field. 
Company Enter the company of the recipient. 
Add’l Information Enter any additional Company information. 
Address * Enter the street address to which the shipment is destined. 
Address Line 2 If more space is needed for the street address, use this field. 
City Mandatory for Canada and USA for a regular shipment only.  Optional for International.  

Enter the city. 
Country Select the destination Country from the drop-down list.  Canada and USA are listed at the 

top for easier access. 
Province/State Mandatory for Canada (for a regular shipment only) and USA (for both regular and 

Quickship shipments).  Optional for International.  If the Country is Canada, a list of valid 
Provinces and Territories in Canada is displayed, sorted alphabetically.  If the Country is 
USA, a list of valid States in the United States is displayed, sorted alphabetically. 

PC (Postal Code)/Zip Mandatory for Canada and USA (for a regular shipment).  Optional for International.  Enter 
the postal code or zip code. 

Contact Phone Enter the telephone number of a contact at the recipient destination who can be called to 
follow up on shipment delivery. 

Tax ID/IRS/VAT This field appears for USA and International destinations only.  If known, enter the 
recipient’s U.S. Internal Revenue Service number or Social Security number or Value 
Added Tax number.  Required for shipping items valued over US$200.00. 

E-Mail Notification? 
Client #1 Internet E-Mail Address of the client, for the purpose of sending an E-Mail Notification. 
E-Mail #2 Second E-Mail Address of the client, for the purpose of sending the E-Mail Notification to 

another address. 
Mailed By This field indicates whether or not the Mailed By Customer will receive e-mail notifications. 
No label (mailed by e-mail) This field contains the e-mail address to be used for e-mail notifications. 

When the Mailed By checkbox is selected, this field is defaulted to the e-mail address on 
the associated Customer window. 
When the Mailed By checkbox is de-selected, this field will be cleared and disabled. 

Behalf of This field indicates whether or not the Mailed On Behalf Of Customer will receive e-mail 
notifications. 

No label (mailed by e-mail) This field contains the e-mail address to be used for e-mail notifications. 
When the Mailed On Behalf Of checkbox is selected, this field is defaulted to the e-mail 
address on the associated Customer window. 
When the Mailed On Behalf Of checkbox is de-selected, this field will be cleared and 
disabled. 

All Notifications Type of E-Mail Notification(s) the user wishes to receive from Event Manager.   
Indicates that the user wishes to receive all notifications (i.e. Induction, Delivery, etc.)   
This is the default. 
Radio button is only enabled if at least one of the E-Mail Notification checkboxes (i.e. 
Client, Mailed By and/or Behalf of) is selected.  

Card Notification Only Type of E-Mail Notification(s) the user wishes to receive from Event Manager.   
Indicates that the user wishes to receive an e-Mail notification only if the parcel could not 
be delivered and a Notice Card was issued to the recipient. 
Radio button is only enabled if at least one of the E-Mail Notification checkboxes (i.e. 
Client, Mailed By and/or Behalf of) is selected.  

Cost Centre This field indicates the internal Cost Centre to which you want to assign the charges of the 
current item 
The drop-down list contains two special entries: 
< None >, which means no Cost Centre, is selected (Null would be stored in database). 
< Add a New Cost Centre >.  When selected initiates P490U 1.2.10 Maintain Cost Centre, 
opening a window where a new Cost Centre can be added.  Upon return to the Shipping 
window, the newly created Cost Centre will be displayed as the selected one. 
The list will be sorted alphabetically, except for < None >, which is first and < Add a New 
Cost Centre > which is second. 
Always enabled. 
Defaulted to < None > when the Shipping window is opened. 
Mandatory when user selects the Cost Centre Required setting on the Shipping 
Preferences window. 

Item Ref #2 A second Reference Number that the user will be able to use to track the package. 
Disabled and blank in Quickship mode or if Delivery Confirmation is not selected. 
Disabled and populated with the value in the Cost Centre drop-down list when the ‘Use 
Cost Centre as Reference #2’ checkbox is selected on the Shipping Preferences window. 
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Command Buttons  
 
 
 
 
Click this button to clear all data fields in the Ship To section, along with any selected checkbox options 
 
 
 
 
Click this button to retrieve client address data via a search on the Client ID, Order ID / Reference #1, Last Name, or Company 
field.  A search on the Client ID field needs an exact match to be successful (i.e. entering “1” will not retrieve entries starting with 
“1”).  Since duplicate Client ID’s are allowed in address books, if more than one client record matches the search criteria, the 
Select Client window appears for you to choose one.  However, the Order ID / Reference #1 field supports partial searches (e.g. 
entering “12” will bring up the Select Order ID / Reference #1 Item pop-up window with all records with Order ID / Reference #1 
values starting with “12” for you to choose one). 
 
A search on the Last Name or Company field does not have to be case-sensitive but needs an exact match for success. 
 
To get a list of ALL client records from ALL Address Books in the application, just click Search.  The cursor can be anywhere on the 
tab; you can also have data in any field EXCEPT for the four search fields above. 
 
Notes:  If an Order ID / Reference #1 Item is missing required data, you must supply this data before processing the transaction. 

 
If you search using an Order ID / Reference #1 value whose record contains a Client ID, the application searches all existing  
address books for this Client ID.  If there is no match, all data in the Order ID / Reference #1 Item record is retrieved as is. 

 
However, if there is a match in an address book, one of the following two actions will happen: 
 

1. If the Order ID / Reference #1 Item record contains all mandatory client address data BUT this data is different from 
that in the address book, the data from the Order ID / Reference #1 Item record overrides the data in the address 
book. 

2. However, if the Order ID / Reference #1 Item record is missing even one mandatory address data value (e.g. the 
city), the address book data is fetched. 

 
 
 
Click this button to void line items on a manifest 
 
 
 
After entering data in the Ship To section (at least the mandatory fields), click this button to add this data as a new client record in 
an existing address book.  The Client window appears with fields populated with this data.  Select the desired address book from 
the Address Book drop-down list and click Save. 
 
 
 
 
After entering the Weight on the Parcel Information section and selecting the Service Type within the Service and Options 
section, click this button to bring up the Group Shipping pop-up window so that you can select the appropriate Group Shipping 
List (either of Clients or Imported Orders) to process. 
 
 Group Shipping List of Clients or Group Shipping List of Imported Orders  
 
To use a Group Shipping List, you must first supply the Weight and Service Type (Service tab) prior to clicking the Group 
Shipping button. 
 
When you click the Group Shipping button, the Group Shipping pop-up window appears.  The Clients drop-down list contains the 
names of all existing Group Shipping Lists of Clients.  The Order ID / Reference #1 drop-down list contains the names of all existing 
Imported Orders Group Shipping Lists.  Choose either a list of clients or one of imported orders.  When you choose one, the other 
field becomes disabled. 
 
Afterwards, in the Sort By drop-down list, choose a field to serve as the sorting criterion (i.e. the order in which the distribution list 
entries will be processed).  The first option is As Created. 
 

Clear <F6> 

Search <F7> 

Void Items 

Add Client <F2> 

 Group Shipping 
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For a Group Shipping List of Clients, there are 12 other sorting criteria:  Client ID, First Name, Last Name, Title, Company, Address 
Line 1, Address Line 2, City, Province/State, Country, Postal/Zip Code, and Phone Number. 
 
For an Imported Orders Group Shipping List, there are 21 other sorting criteria Order ID / Reference #1, Client ID, First Name, Last 
Name, Title, Company, Additional Address Info, Address Line 1, Address Line 2, City, Province/State, Postal/Zip Code, Country, 
Voice Phone Number, Weight, Article, Length, Width, Height, COD Amount, and Method of Collection. 
 
Click Process.  If there are errors, they are displayed in the Group Shipping Processing Errors pop-up window.  You are asked if 
you want to create a group shipping list of the clients that were not successfully processed for later processing after correcting the 
errors.  If you click Yes, you are prompted to enter a name for the list. 
 
Examples of processing errors are missing customs information, invalid Service Type for selected destinations (Note:  for an 
Imported Orders Group Shipping List, this error is worded as “Service Type is a mandatory field”), invalid Postal Code, and 
unacceptable parcel measurements. 
 
ATTENTION!  Records in the Group Shipping List that have no errors do get processed by the application. 
 
Quickship  
 

 
 
Access this widow by clicking the Quickship command button on the Ship to section of the Shipping window. 
 
Overview 
If you don't need Electronic Shipping Tools to print address labels for you, you can choose the Quickship option. For accurate 
rating, all you need to enter to Quickship is the destination FSA (a full postal code is required for rural destinations). 
 
You can also enter the Order ID / Reference #1 and Number of Pieces. 
 
To print a Quickship Address Label, check Print Quick Ship Address Label on the Service and Options section of the Shipping 
window  (Quickship normally suppresses the label printing, on the assumption that your label has been produced using other 
means). 
 
An address label contains the client address, along with the barcode and item identifier.  If you do not need Electronic Shipping 
Tools to print address labels for you because they have been produced using other means, such as another application or filling in 
service type waybills, select the Quickship checkbox.  For accurate rating, all you need to enter to Quickship is: 
 

• (For Canada) the destination FSA.  A full Postal Code is required for rural and commercial air stage freight destinations. 
• (For USA) the destination State. 
• (For International) no other information is required. 

 
When Quickship is chosen, all fields in the Ship To section become disabled except for Order ID / Reference #1 and Country, 
Province/State and PC depending on the destination, E-Mail notification information, and Cost Centre.  Also, the Search button 
becomes disabled. 
 
Quickship suppresses label printing.  However, if your own labels have only client address data, you can print Quickship address 
labels, which have just the bar code and item identifier. 
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Note:  To print the Quickship label, BOTH the Print Address Label and Quickship checkboxes must be selected.  Furthermore,  
the FULL Postal Code is required for printing. 

3.4 Parcel Information Section 
 
Supply the parcel information in the parcel information section.  You can manually enter the size and weight or select a 
predefined container from the Containers drop-down list.  The container field has an “Add a New Container” selection in its drop 
down menu which allows you to create pre-defined container information (weight, length, width, height) for repeat mailings (i.e. CD 
Boxes always have the same weight and dimensions). 
 
Weight is the only mandatory field.  However, if you enter a value for Length, Width, or Height, you are required to enter values 
for the other two Size fields. 
 
 
 
 
 
Clicking on this button will populate the Weight field with weight from an attached scale 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Document checkbox becomes enabled ONLY when the selected Service Type allows prepaid documents.  Selecting the 
Document checkbox disables the Customs button (this is different from the Internet version). 
 
Enter the number of pieces in the shipment.  The default value is “1”. 
 
Default Settings 
 
The following defaults can be set as follows.  Select Site Information from the Data Maintenance menu.  Choose the Shipping 
Preferences command button, then the Shipping tab. 
 
1. For the unit of measure, you can switch between Metric and Imperial.  From the Measurement Units drop-down list, choose 

the desired option. 
2. Enter the desired default value in the No. of Pieces field if different from “1”. 
3. If you want a default-predefined container, select it from the Containers drop-down list.  
4. If you choose Manually Scan/Type Ids as your Item Identifier default, a Shipping Info Required pop-up window will appear.  

It will prompt you to enter a valid barcode in the Identifier field.  You can change the default to have the application use 
system-generated ID’s. 

 
 
 

Parcel Information Section 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Parcel Information To specify the weight and dimensions of the shipment (in the unit of measure specified in 
Shipping Preferences). 

Container Allows selecting a pre-defined container to automatically populate the weight and 
dimension fields (i.e. CD Boxes always have the same weight and dimensions). 

Refresh Weight <F8> 
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The drop-down list is always enabled and contains a blank entry and a special entry: 
Use the Container window to add a new shipping container type to the container list, 
remove existing ones or modify the properties of existing ones.  
 
The list will be sorted alphabetically. 

Pieces To specify the volume of the shipment 
Weight* To specify the weight of the shipment.  Can be manually entered, populated from the 

selected container or polled from a scale. 
Length To specify the length of the shipment 
Width To specify the width of the shipment 
Height To specify the height of the shipment 
Document Indicates whether or not the shipment is a document 

3.5 Service and Options Section 
 
This section allows you to select a Distribution service and add options related to this service.  The value fields remain the same; a 
value must be entered where required.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
In this section, select the Service Type and any desired options.  Only services that are available to the contract currently selected 
are listed in the Service Type drop-down list.  The list of available options change depending on the Service Type.  If there are 
options included with the Service Type, they are already selected and you cannot deselect them. 
 
Once you select the Service Type, if there is only one open Manifest that accumulates transactions of that Service Type, the 
Manifest name (i.e. date and time of creation), along with its Local ID, appears in the Manifest field.  The field is display-only.  If 
there is currently more than one manifest open for that Service Type, they appear in the Manifest drop-down list.  You must select 
one, and then the field becomes display-only.  However, if there is no existing Manifest, the field remains blank.  When the 
transaction is processed, the corresponding Manifest is automatically created by the application. 
 
Manifests are created in this order: 
 

1) Mailed On Behalf Of customer number (i.e. you can have the same manifest type open for different customer numbers) 
2) Method of Payment for each customer number (i.e. for one customer number, you can have the same manifest type 

open for different methods of payment). 
3) Service Types for each customer number (click here for a listing of Manifest Types, and their associated Service Types) 

 
Notes:  Some International services and service options may not be available for every destination Country 
 
Regarding Coverage for International destinations, if you get the error message “The value exceeds the maximum threshold of 
0.00,” this means that Coverage is NOT available at all for that destination Country. 
 
If you wish to ship a parcel with the COD option, select the method of collection (COD Collection) from a drop-down list and enter 
the COD / Manual identifier when required. 
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The initial focus is on the Service Type field.  If the current destination Country (i.e. Canada, USA, or International) is the same as 
that of the last successfully processed transaction, the Service Type of the last transaction appears, along with the associated 
Manifest in the Manifest field. 
 
The list of available Service Types is also filtered according to the Country chosen on the Ship tab.  However, if no Country has 
been chosen yet, ALL Service Types are listed in the drop-down list. 
 
Note:  If, for some reason, the Country field is blank but not all Service Types appear in the drop-down list, just go back to the Ship 

section and click Clear. 
 
ATTENTION!  It is advisable to choose the Country first.  If you choose the Service Type first and then choose a Country for  
which that Service Type is not available, the Service Type field is cleared. 

 
If the client address data in the Ship To section is obtained via a search on the Order ID / Reference #1 in which the 
associated Client ID is found in an existing address book, then the list of available Service Types is NOT filtered based on the 
retrieved destination Country.  Thus be aware to select a Service Type that is offered for the particular destination Country. 
 
When you change the Service Type, the Service field in the Calculate Preview frame changes accordingly.  However, you 
must click Calculate again to obtain the costs of the new Service Type. 

 
Default Setting 
 
When the Delivery Confirmation option is selected (be aware that it can be automatically included with a Service Type, such as 
for all domestic services), an (Item) Identifier must be supplied.  You can set the application to use system-generated ID’s, or 
prompt the user to manually scan/type ID’s.  Select Site Information from the Data Maintenance menu.  Choose the Default 
Settings tab, then the Shipping tab.  Under Item Identifier, choose the desired radio button. 
 
 
 

Service and Options Section 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Service Drop Down List Shipping and Delivery Services Mailing services available to the Contract currently 
selected.  The Service Type drop down list is also filtered by the Destination Category (i.e. 
only domestic services will be listed if the Ship to Country is Canada, etc) 

(Option) Description Non-contracted options that are applicable to the selected service and country, and 
contract-specific options available to the currently selected contract. 

Options – select checkbox Indicates whether or not the service option on that line has been selected. 
Some options are automatically selected for a given service or are a pre-requisite for other 
options (i.e. Delivery Confirmation is included with Signature, Coverage and COD). 
Some options are mutually exclusive with others and selecting the first disables the other 
one. 
All these combinations and the related GUI manipulations (i.e. enabling, disabling and 
selecting options) are assumed to be driven from the local pricing engine. 

Value Value (dollar amount) associated with the service option. 
COD Collection The drop down list contains all the valid Method of Collections for COD. 
COD / Manual Identifier User-supplied identifier/Barcode associated with the item. 

Enabled only when Delivery Confirmation is available and: 
The setting to manually type or scan the barcode is selected (on Shipping Preferences 
window); or 
The COD option is selected and the label will NOT print on thermal paper 

3.6 Charge To Information Section 
 
Payment information is recorded in the pop-up screen (below right).  Enable this screen by clicking on the update button in the 
Charge To Information section (below left).  Within this pop-up window, supply the payment information for the transaction, such as 
the Mailed On Behalf Of customer number and Method of Payment.  Click the apply button to return to the Charge To Information 
section. 
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Charge To Information Section 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Mailed By The current Customer Number 
Mailed on Behalf Of* The customer number of the owner of the Mailing 
Contract* The Contract (Number and Alias) on which to assign the item 
Paid By Customer* The customer number of the customer paying for the Mailing 
Method of Payment* Indicates the customer’s chosen method of payment for the mailing 
Selected Credit Card Indicates the credit card that will be used for payment purposes 
Outlet Number and name (e.g. “9999 – Outlet Name”) of the Canada Post location where the  

mailing  will be inducted 
 
Command Buttons 
 
 
 

Clicking on the Apply button: 
� Performs validations. 
� Saves the changes to the local database. 
� Closes the Charge To Information window. 
� Triggers a refresh of the Shipping window (for new Charge To Information, and defaults associated to new Customer). 

 
 
 
Closes the Charge To Information page 
 
Credit Card Data Entry Pop-Up Window 
 
Access this pop-up window by selecting Credit Card from the Method of Payment drop-down list on the Charge To Information 
section of the Shipping window.  The Selected Credit Card field becomes enabled.  Choose Other from the drop-down list. 
 

 
 
Select the desired option from the Credit Card Type drop-down list.  Enter the Credit Card Number, Expiry Date, and Credit Card 
Owner name.  Click Apply. 
 
Entering credit card information on this window is for one-time use only.  An alias (which contains the first and last four digits of the 
credit card number with the remainder being asterisks) is created to serve as an option in the Credit Card Type drop-down list 
afterwards. 
 
If you have credit card numbers that you use regularly, you can establish them as aliases so that they appear in the Selected Credit 
Card drop-down list for selection on the Charge To section and thus you do not have to repeatedly enter the credit card information.  
To do this, supply the credit card information when you are having your Customer Profile set up on the CPC database. 
 
ATTENTION!  Even though you are allowed to select Credit Card as your Method of Payment and either choose a credit card 

alias or enter in credit card information, the transaction is processed ONLY IF the Mailed By and Paid By customer numbers 
are the same on the Charge To section. 

Apply 

Cancel 
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Command Buttons 
 
 
 
Click this button to initiate validation of the entered values.  If there are no errors, the Credit Card Data Entry window is closed. 
 
 
 
Click this button to return to the Shipping window. 
 
 
 

Credit Card Data Entry Window 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Credit Card Type * Select the desired credit card type from the drop-down list. 
Credit Card Number * Enter the complete credit card number. 
Expiry Date * Enter the credit card expiry date in MM/YY format. 
Credit Card Owner * Enter the name of the credit card owner. 
 
The Mailed On Behalf Of field is initially populated with the selected customer number on the Customer menu.  When you change 
the customer number via the Customer menu, this field changes to reflect the new number.  If you select a new customer number 
via this field, the change is reflected on the Customer menu. 
 
If you select a Mailed On Behalf Of customer number that has a previous successfully processed transaction, the data for this 
transaction populates the Charge To section and the application automatically switches to the Ship To section (which may also 
contain data from the previous transaction).  If the Mailed On Behalf Of customer number has no previous transaction, any data 
present is cleared. 

Customs Procedures 

 
 
Access this window by clicking the Customs button on the Shipping window. 
 
Customs information is never required for domestic shipments.  Therefore, the Print Customs Document checkbox and Customs 
button are not enabled when the destination Country is Canada. 
 
BOTH the Country on the Ship To section, and Service Type on the Service and Options section, must be selected to enable the 
Customs button.  Since customs information is mandatory for Purolator Intl PuroLetter, Purolator Intl PuroPak, Purolator 
International, and Commercial* Expedited Parcel - USA, this is all that is required to access the Customs window. 
 
However, if the Service Type is not one of the above-mentioned, the Print Customs Document checkbox must also be selected to 
enable the Customs button. 

Cancel 

Apply 
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ATTENTION!  The total weight of all goods listed for customs purposes must not be greater than the keyed item Weight on the 

Ship To section of the Shipping window. 
 
The Customs window collects all the required data elements to complete the appropriate document type for the shipment.  The 
business rules around customs declaration by service have been coded into Electronic Shipping Tools.  The collection of mandatory 
information will reduce the necessity for the user to understand customs reporting and declaration rules.  Different information is 
needed depending on the customs document required, so certain fields are disabled according to the type of document to produce. 
 
Printing of the customs document occurs when you click Process/Print ONLY IF the Print Customs Document checkbox has 
been selected.  Note:  There is no preview functionality of customs information prior to printing it as in the Internet version. 
 
The Customs window stores customs information that is to be printed on the appropriate customs document.  It consists of two 
sections.  The characteristics of this window are outlined below: 
 

Customs Window Section Window Characteristics 
1. Summary Information about the 

Shipment 
This section consists of header information such as the total value (for customs 
purposes) of the shipment, the currency used to define this value, the reason for 
export, non-delivery instructions, and duty taxes paid on the shipment.  It also 
contains a reference number that you can supply for audit purposes. 

2. Goods and Contents This section allows you to describe in detail the contents of the shipment.  Your 
list can be a combination of predefined goods and items that you define for one-
time use only.  If printed, the actual customs document will be supplemented with 
data received from the Shipping window. 

 
Command Buttons 
 
(Following two buttons are located within the Selection from Predefined Goods frame) 
 
 
 
Click this button to access the Pre-defined Goods window to enter data for new predefined goods.  Upon saving the data, the new 
goods description is inserted in the Description drop-down list for selection. 
 
 
 
This button becomes enabled when the Quantity value has been entered.  Click it to add the selected predefined goods description 
to the Description of Shipment Contents frame list. 
 
(Following three buttons are located at the right within the Description of Shipment Contents frame) 
 
 
 
Click this button to access the Maintain Goods window to enter data for goods that are included in this particular shipment (i.e. one-
time use). 
 
 
 
Click on a line item in the Description of Shipment Contents frame list to select it.  This button becomes enabled.  Click it to edit 
the line item.  The Maintain Goods window appears. 
 
You can also double-click on a line item to bring up the Maintain Goods window for editing. 
 
Note:  If you edit a line item that is predefined goods, the changes apply ONLY to this particular line item (i.e. the data of the 

predefined goods remains unchanged). 
 
 
 
Click on a line item in the Description of Shipment Contents frame list to select it.  This button becomes enabled.  Click it to 
remove the line item from the list.  A Yes/No confirmation pop-up window appears. 
 
(Following two buttons are located at the bottom of the Customs window) 

New 

Apply 

Add 

Delete 

Edit 
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Click this button to save the customs information and close the Customs window. 
 
 
 
Click this button to exit the Customs window without saving the new customs information or changes to existing information.  Even 
if you did not enter any data or make any changes, a Yes/No/Cancel confirmation pop-up window always appears asking you if you 
want to save your changes. 
 
 
 

Customs Window 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Summary Information Section 
Reference Number Enter any reference number or code that you want to use to identify the shipment.  

Maximum of 15 characters. 
Customs Currency * Enter an abbreviation for the currency used to record the total value of goods in the 

shipment. 
Customs Value For Purolator Intl PuroLetter transactions, enter the value of the shipment. 

 
For other shipments, this field shows the total value of the shipment calculated from 
the detailed description of the shipment contents.  It changes as items are 
added/deleted.  You cannot change this value directly. 

General Description Enter a general description of the shipment contents. 
Duty and Tax Display-only.  Calculated by the application based on the total value of the goods in 

the detailed description of the shipment contents. 

Reason for Export  
� Commercial Sample 
� Gift 
� Trade Show 
� Repair Warranty 
� Document 
� Other/Not applicable 

Always enabled unless the Service Type is Purolator Intl PuroLetter.  
For Xpresspost International, Xpresspost USA,  Xpresspost USA Prepaid or USA & 
International Small Packets services, this field is optional and defaults to a blank line. 
Otherwise, the field does not contain a blank line and defaults to the first value in the 
list. 
 

Non Delivery Instructions: 
Treat As Abandoned 
Return to Sender Via Surface 
Return to Sender Via Air 

 Instructions as to what to do with the shipment if undeliverable.  Always enabled, 
with no blank entry line available. 
The Non Delivery Instructions drop down list is filtered based on the Service Type 
selected:: 
For USA or International Small Packets Surface, only Return to Sender Via Surface 
is displayed. 
For USA or International Small Packets Air, only Return to Sender Via Air is 
displayed. 
For a service that produces the Commercial Invoice or Service Type of Xpresspost 
International, only Treat As Abandoned is displayed. 
For all other services, default to Treat as Abandoned. 

Additional Information Additional information/comments relevant to the shipment to aid the customs agent 
in clearing the package. 

Goods and Contents Section 
Selection from Predefined Goods - 
Description 

From the drop-down list, select the desired description of goods that have been 
predefined using the Pre-defined Goods window.  Select first prior to entering 
corresponding quantity in adjacent field. 
 
By predefining the goods that you ship, you can quickly build a detailed description 
of the shipment for customs purposes. 

Selection from Predefined Goods - Quantity Mandatory if a predefined goods description is selected.  Enter the quantity of these 
goods that are included in the shipment. 

Description of Shipment Contents frame Lists the quantity, inventory number, description, unit weight, and other related data 
of all the goods in the shipment.  Display-only.  Taken from data entered for chosen 
predefined goods and for one-time goods defined via the Maintain Goods window. 
Refer to the field descriptions of the Maintain Goods window. 

Primary Origin of Goods – Country of Origin From the drop-down list, select the country in which the shipment contents were 
manufactured. 

Primary Origin of Goods – Province of Enabled only when the selected Country of Origin is Canada AND the destination 

Apply 

Cancel 
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Origin Country is USA.  From the drop-down list, enter the province in which the shipment 
contents were manufactured. 

 
Maintain Goods Window 
 

 
 
Access this pop-up window by clicking the Add button at the right within the Description of Shipment Contents frame of the 
Customs window. 
 
Use this window to enter data for goods that are included in one particular shipment (i.e. for one-time use only).  This means that 
these goods will not appear in the Description drop-down list in the Selection from Predefined Goods frame. 
 
Command Buttons 
 
 
 
Click this button to save the new data or changes made to existing data and close the Maintain Goods window.  If you have 
entered new data, it is displayed in a line item for the one-time goods in the Description of Shipment Contents frame list upon 
return to the Customs window. 
 
 
 
Click this button to exit the Maintain Goods window without saving the new data or changes to existing data.  Even if you did not 
enter any data or make any changes, a Yes/No/Cancel confirmation pop-up window always appears asking you if you want to save 
your changes. 
 
 
 

Maintain Goods Window 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Item / Part / SKU # Enter any inventory number or code that you want to use to identify this individual item.  
Maximum of 15 characters. 

Quantity *  
Description * Enter a description of the individual item. 
Unit Weight Enter the weight of the individual item. 
Customs Value * Enter the value of the individual item for customs purposes. 
Tariff Code Enter the three-character tariff code. 

 
The tariff code is based on the origin of the goods and any trade agreement supporting 
the import and export of those goods.  The tariff is applied through commodity rating by 
Customs or a Customs Broker/Traffic Manager. 

HS Code Enter the Harmonized System (HS) number of the item. 
 
The HS Code is used by customs to identify items in a shipment, allowing faster 
clearing of a shipment. 

Duty Rate Enter the percentage duty rate that applies to the current goods. 
 
The duty rate is based on the rate assigned to the goods using the Harmonized Tariff 

Apply 

Cancel 
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Schedule by Customs or a Customs Broker/traffic manager. 
Duty Amount Display-only.  This field shows the amount of duty payable on one item, based on the 

Duty Rate. 
 
Before the goods are shipped, the Duty Amount is multiplied by the shipment quantity 
to determine the total duty. 

Tax Type the tax payable on one item.  You can use this field to specify any national tax 
stipulated by the destination Country, as identified by Customs or a Customs 
Broker/Traffic Manager. 
 
Before the goods are shipped, the Tax amount is multiplied by the shipment quantity to 
determine the total tax. 

Excise Type the excise tax payable on one item.  This field is used to record any tax on luxury 
items as assigned by the destination Country.  Customs or a Customs Broker/Traffic 
Manager identifies the excise tax value during the commodity rating process. 
 
Before the goods are shipped, the Excise amount is multiplied by the shipment quantity 
to determine the total excise. 

Territory Tax Type the territory tax payable on the current goods.  You can use this field to specify 
any provincial, state, or territorial tax stipulated by the destination Country, as identified 
by Customs or a Customs Broker/Traffic Manager. 
Before the goods are shipped, the Territory Tax amount is multiplied by the shipment 
quantity to determine the total territory tax. 

VAT Type the Value Added Tax (VAT) payable on the current goods.  When shipping to 
international destinations, use this field to record the VAT or other similar tax, if 
applicable, as identified by Customs or a Customs Broker/Traffic Manager. 
 
Before the goods are shipped, the VAT amount is multiplied by the shipment quantity to 
determine the total VAT. 

Country of Origin From the drop-down list, choose the country in which the item was manufactured. 
Province Enabled only when the selected Country of Origin is Canada AND the destination 

Country is USA.  From the drop-down list, enter the province in which the item was 
manufactured. 

 
Enabled Fields According to Service Type 
 

USA Services International Services Both USA and Int’l 
1. Xpresspost USA 5. International Parcel Air 9. Purolator Intl PuroLetter 
2. Xpresspost USA Prepaid Ind 6. International Parcel Surface 10. Purolator Intl PuroPak 
3. USA Small Packets Air Mail 7. Intl Small Packets Surface 11. Purolator International 
4. USA Small Packets Surface 8. Intl Small Packets Air  
 
Refer to above table for service number (e.g. Xpresspost USA has service number 1).  Service numbers have no meaning outside 
of these tables. 
 
 SERVICE NUMBER 
FIELD NAME 1 2 3 4 5 6 7 8 9 10 11 
Reference Number √ √ √ √ √ √ √ √ √ √ √ 
Customs Currency √ √ √ √ √ √ √ √ √ √ √ 
Customs Value         √   
General Description         √ √ √ 
Duty and Tax * * * * * * * * * * * 
Reason for Export √ √ √ √ √ √ √ √  √ √ 
Non Delivery Instructions √ √ √ √ √ √ √ √    
Additional Information         √ √ √ 
Goods and Contents frame - 
Description 

√ √ √ √ √ √ √ √  √ √ 

Goods and Contents frame – Primary 
Origin of Goods 

        √ √ √ 

 
Display-only.  Calculated by the application. 
 
A Customs Document, a Customs Declaration Dispatch Note, or a Commercial Invoice is produced, depending on the Service Type 
used and the Declared Value for Customs: 
 
1. Prints the Customs Document when: 
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• The Destination Country is USA, except for Commercial* Expedited Parcel – USA or; 
 
• The Service Type used is International Small Packet (Air or Surface) and the total Declared Value for Customs is less 

than or equal to $300.00. 
 
• One (1) copy is generated. 
 

2. Prints the Customs Declaration Dispatch Note when: 
 
• The Service Type used is International Parcel (Air – where available - or Surface) or; 
 
• The Service Type used is Xpresspost – International where applicable or; 
 
• The Service Type used is International Small Packet (Air or Surface) and the total Declared Value for Customs is greater 

than $300.00. 
 
• Four (4) copies are generated. 
 

3. Prints the Commercial Invoice when: 
 

• The Service Type used is Commercial* Expedited Parcel – USA.  The Service Type used is Commercial* Expedited 
Parcel – USA.  One copy is generated if required.  The Commercial Invoice will only be generated and printed if the user 
has selected the Print Customs Document checkbox. Copy (ies) must be inserted into the plastic pouch.  

 
• The Service Type used is Expedited Parcel  – USA.  One copy is generated if required.  The Commercial Invoice will only 

be generated and printed if the user has selected the Print Customs Document checkbox. Copy (ies) must be inserted into 
the plastic pouch. 

 
Note:  To have the application print the customs document, you must select the Print Customs Document checkbox on the 

Ship To section of the Shipping window. 

Additional Procedures for Commercial* Expedited Parcel - USA 
 
When shipping items valued over US$200.00, Electronic Shipping Tools will prompt you to supply the following data items in order 
to take full advantage of Commercial Customs Clearance: 
 

• Recipient’s U.S. Internal Revenue Service number or Social Security number; 
 

• Appropriate customs Harmonized System code and; 
 

• Country and province (only if the country is Canada) of the manufacturer of the item(s) shipped. 
 
Once the daily customs information is received electronically, it will be forwarded to Canada Post’s broker, PBB Global Logistics. 
 
To set up your account with PBB, simply complete the documentation available at this address: 

 

Manifest Types and Associated Service Types 
 
The following list is effective as of July 2003: 
 

MANIFEST TYPE SERVICE TYPES 
Commercial Air Stage Freight ASF Non Food Items 

ASF Non Food Items Rate G 
ASF Nutrit. Perish Food Rate A 
ASF Nutrit. Perish Food Rate E 
ASF Other Food Rate B 
ASF Other Food Rate F 
Inuvik Nutritious Perish Food 

Domestic Bulk Exp. Parcel Piece/Kilo 
Reg. Parcel Piece/Kilo 

Commercial* Expedited Parcel USA/Xpresspost Xpresspost USA 
Xpressost USA Prepaid Ind 

International Courier Purolator Intl PuroLetter 
Purolator Intl PuroPak 
Purolator International 

Priority Courier Priority Courier Piece Rated 
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Priority Courier Prepaid Ind 
Regular/Expedited/Xpresspost Expedited Parcel Piece Rated 

Regular Parcel Piece Rated 
Xpresspost Piece Rated 
Xpresspost Prepaid Induction 

USA/International Intl Small Packets Air 
Intl Small Packets Surface 
International Parcel Air 
International Parcel Surface 
USA Small Packets Air Mail 
USA Small Packets Surface 

Xpresspost International Xpresspost International 
 
 

4.0 Customer Menu  
 

 
 
The Customer menu displays the Mailed On Behalf Of customer names, along with their numbers, that are configured on your 
Electronic Shipping Tools desktop application.  The Mailed On Behalf Of customer is the customer who owns the mailing (i.e. the 
customer on behalf of whom the mailing is being prepared). 
 
When you have more than Mailed On Behalf Of customers, use the Customer menu to select the appropriate one.  Note that your 
selection here will affect the contracts and services available in subsequent windows. 
 
When you select the desired customer number via the Customer menu, the Mailed On Behalf Of field in the Charge To section of 
the Shipping window becomes populated with this number.  You can also change the customer number by selecting from this 
field’s drop-down list.  If you do this, the change is reflected in the Customer menu. 
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5.0 Security Menu  
The Security menu is available only when Security Enabled is selected on the Options tab in the Site Information window. 
 
Use the Security menu to add and delete Electronic Shipping Tools users, and determine the Electronic Shipping Tools functions 
they are allowed to access. 
 
User Profile Window 
Access this window by selecting User Profile from the Security menu 
 

 
. 
Overview 
As a system administrator, use the User Profile window to add new Electronic Shipping Tools users to the system, and assign 
access privileges to those users. You can also delete users, or modify the information for existing users. You will need 
administration privileges in your profile to perform the functions on this window. 
 
Command Buttons  
 
 

SECURITY MENU 
COMMAND OR 
MENU ITEM 

RESULT OF INVOCATION 

User Profile list 
 
List View 

Select a User Profile 
Display User Profile detail information in the User Profile information section 
User Ids must be greater than 5 characters. 
 

Delete  Delete Selected User Profile in the User Profile List View from the local database 
Reset Password Resets the Password of the selected User Profile. The Password is set equal to the User Id.  Passwords 

can be a maximum of 8 characters. 
New  Allows you to create a New User Profile in the local database 
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Access Privileges 
 

OPTION ACCESS PRIVILEGE 

Administration Allows the user to perform system functions such as hardware set-up, user set-up, etc. 

Address Book Allows the user to add customers to Address Books, or to add or delete Address Books. 

Trace Queries Allows the user to initiate delivery confirmation queries. 

Order Creation Allows the user to create, modify or delete orders. 

Reporting Allows the user to generate and print reports. 

6.0 Data Maintenance Menu 

 
 
Use the Data Maintenance menu to manage your customer data and site information.  You can also configure many aspects of 
Electronic Shipping Tools from this menu, along with assigning aliases (i.e. meaningful names) to contracts and cost centers. 

6.1 Orders Items 
The Order Items submenu provides two options.  Select Import to access the Open File – Import Order Items pop-up window, 
where you can import order entry information created in other applications.  Select Maintain Imported Order Items window, where 
you can edit and delete imported order items, import more order items, or even create new order items. 
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Import Order Items 

 
Access the Open File – Import Order Items pop-up window by selecting Order Items – Import from the Data Maintenance menu 
or clicking the Import button on the Imported Order Items window. 
 

 
 
Use this window to import order entry information produced outside of Electronic Shipping Tools into the application database.  After 
you import a file of Imported Order Items, they appear in the frame list of the Imported Order Items window (Data Maintenance 
menu > Order Items > Maintain). 
 
The Import Order Items functionality leverages the Sell Online Engine to allow interface to the shipment details created through the 
website interface solution. 
 
Electronic Shipping Tools uses a standard Window file location window to prompt you for the name and location of the file to import.  
Follow the prompts to locate and import the mailing item add-ons (import order) information. 
 
IMPORTANT REGARDING VALIDATION!  The Import functionality performs only simple formatting-related edits.  It does NOT 
enforce the application’s business rules.  This means that you can import completely wrong data, such as non-existent article 
numbers (representing Service Types) and service options selected for Service Types that do not offer them.  However, when you 
try to process this data in the application, it will be rejected.  However, in the latter example, you will not get any kind of error or 
notification message; the application will just not apply charges for invalid options. 
 
The entire file is rejected if even just one record does not contain the correct number of fields as delimited by commas. 
 
For the Electronic Shipping Tools record types, the only fields that are mandatory to pass import validation are Record Type, Order 
ID / Reference #!, and Service (Record Type 3 only).  If there are records with these fields missing, they will not be processed.  
Their errors are captured are captured in an Imported Order Entry Error File for your review.  All other records are processed by 
the application. 
 
Keep in mind, though, that some optional (for import validation) fields are REQUIRED for the application’s business rules, 
such as Address Line 1 and Country Code.  These fields could be obtained via address books if the associated Client ID exists 
in them, so be aware. 
 
Duplicates:  The application does NOT filter out even exact (i.e. field per field) duplicate records.  Be aware of this so as not to 
clutter the application database. 
 
ATTENTION!  If you are manually creating a text file via a text editor, do NOT press <ENTER> after the last record. 
 
Record Types with Electronic Shipping Tools 
 
Two types of Original records containing order entry data can be imported using this window: 

1. Record Type 2, which contains exactly 19 fields. 
2. Record Type 3, which contains exactly 44 fields, of which the first 19 are those of Record Type  

 
 
Four types of extended records containing order entry data can be imported using this window: 

1. Record Type 4, which contains exactly 23 fields. 
2. Record Type 5, which contains exactly 52 fields. 
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3. Record Type 6, which contains exactly 66 fields. 
4. Record Type 7, which contains exactly 17 fields. 

 
For further information regarding the layout of the imported files, please access the following link; 
http://www.canadapost.ca/business/offerings/eship_tools/pdf/import_specs-e.pdf 
 
File Format 
 
The import file must be a comma-delimited ASCII flat file where character and non-integer numeric fields are enclosed in double 
quotes (“).  Where no information is available, you need not enter a blank entry (i.e.  “”) EXCEPT if it is the last field. 
 
Click here if you are reading this guide online to view the Order Entry File Structure.  If not, please visit the Canada Post website 
(www.canadapost.ca) > Business > select Electronic Shipping Tools from the Shipping and Delivery drop-down list > Benefits and 
Features (at right) > click on Distribution at bottom > Order Entry more… > to see the Order Entry File Structure. 
 
For the most current details on import file specifications, contact the Electronic Shipping Tools Help Desk weekdays from 7:00 am to 
8:00 pm (Eastern Standard Time) at 1-800-277-4799. 
 

 
 
Command Buttons 
 
 
 
Click this button to initiate the Search process.  Only those records that match the entered search criterion in the specified field are 
displayed in the frame.  You can search on the following fields:  Order ID / Reference #1, Client ID, First (Name), Last (Name), 
Company, City, Province/State, and Country Code. 
 
Note:  You cannot search for records that have a blank entry for a particular field.  Even though this button is enabled with no search 

criterion entered, the Search functionality does NOT return such records. 
 
 
 
Click this button to access the Maintain Imported Order Items window tabs to create your own “Imported” Order Items. 
 
 
 
Click this button to access the Open File – Import Order Items window to locate a file of Imported Order Items to import into the 
application database. 
 
 
 
Click on an Imported Order Item in the frame list to select it.  Click this button to access the Maintain Imported Order Items 
window to modify the data of this Imported Order Item. 
 
You can also access this window for editing by double-clicking on the Imported Order Item in the frame list. 

Find 

Add 

Import 

Edit 
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Click on an Imported Order Item in the frame list to select it.  Click this button to delete it.  A Yes/No confirmation pop-up window 
appears. 
 
 
 
Click this button to exit the Imported Order Items window. 

Maintain Imported Order Item 
 
Access this window by clicking Add (to create your own “imported” order item record) or Edit (to modify the data of the selected 
Imported Order Item) on the Imported Order Items window. 
 

 
 
Overview 
The Maintain Imported Order Items window is used to edit Imported Order Items that you have imported via a file from another 
system or application, although you may also use it to create your own “Imported” Order Items as needed. 
 
On the Client Info tab, the initial focus is on the Country Code field.  When the Country Code is selected, the Postal/Zip Code 
field becomes enabled.  Also, if the Country Code selected is for Canada or USA, the Province/State field becomes a drop-down 
list populated with the valid values.  On the Service Info tab, the initial focus is on the Service field.  On the Size & Weight tab, the 
initial focus is on the Weight field. 
 
The only mandatory field for the three tabs is Order ID / Reference #1.  However, keep in mind that certain fields, such as all three-
size fields, are required to pass the application’s business rule validations. 
 
If the Client ID matches a defined recipient in your address books, that recipient’s information will be associated with the Imported 
Order Item ONLY IF the Imported Order Item does not contain all mandatory data for the Ship To section of the Ship tab of the 
Shipping window. 
 
ATTENTION!  If you edit an Imported Order Item that does not have a Service Type selected for it, and you do not add one, you 

get the message “Removing the Service Type will remove all Service Info.  Proceed anyway?  Y/N”. The application is just 
reminding you that you may want to enter a Service Type for that particular Imported Order Item.  Otherwise, the Service 
Type chosen on the Service and Options section of the Shipping window will be used. 

 

Delete 

Close 
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Client Info Tab 
 

 
 
 

Client Info Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Client Info Tab 
Imported Order ID* A unique number or other identifier that you use to identify this order item.  Once 

defined, you should not change the Imported Order ID in order to maintain a proper 
audit trail of your shipments. 

Client ID A unique number or other identifier that you use to identify the recipient associated 
with this order item. 
If you use the same identifier as used for a defined recipient in your address books, 
additional information for this recipient will be automatically taken from the defined 
recipient’s record ONLY IF the order item does not contain all mandatory data for the 
Ship To section of the Shipping window. 

First (Name) The first name of the recipient associated with this order item. 
Last (Name) The last name of the recipient associated with this order item. 
Title/Dept The title of the principal contact at the recipient, and/or the department to which he 

belongs. 
Company The company name of the recipient. 
Additional Address Info Any additional address information not provided in the other address fields of the 

order item. 
Note:  This item is included for future use only and is not currently printed on your 

address labels. 
Address Line 1 Enter the street address of the recipient. 
Address Line 2 If more space is needed for the street address, use this field. 
City The municipality/city of the recipient. 
Province/State This field’s label changes depending on the Country selected.  It contains the 

Province or State of the recipient.  For Canada and the United States, the provinces 
and states are available using a drop-down list. 

Postal/Zip Code This field’s label changes depending on the Country selected.  It contains the Postal 
Code or Zip Code of the recipient. 
For the Postal Code, the application enforces the format A9A 9A9 and automatically 
enters the required space. 

Country Code From the drop-down list, select the appropriate country of residence of the recipient. 
Voice Phone Number The main telephone number of the recipient. 
Fax # Enter the recipient Fax # associated with this order item(if desired) 
E-Mail Enter the recipient e-mail address associated with this order item (if desired) 
Tax ID/IRS/VAT  
Item Reference #2 Enter a second item reference #, if required 
E-mail #2 Enter a second email address, if required 
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Service Info Tab 
 

 
 
 
 

Service Info Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Service Info Tab 
Service Type Select the shipping product offered by Canada Post that should be used when 

shipping this order item. 
You can select from all available products.  Therefore be aware to select a product 
that you use at your site AND that is available for shipping to the recipient's address 
(e.g. do not select a domestic product for international shipments). 
On this tab, the application does not validate the service options against the selected 
Service Type.  Therefore be aware to select options that are available for the 
selected Service Type.  Also, if you change the Service Type, remember to update 
the service options. 

Document Indicator Select to indicate that you are shipping a document. 
Delivery Confirmation Indicator Select to indicate that you want confirmation of delivery. 
Oversize Indicator Select if the package to be shipped should incur extra charges for exceeding the 

allowed dimensions for the selected Service Type. 
Signature Indicator Select if you require Canada Post to record and make available the name of the 

person who signed for delivery. 
Do Not Safe Drop Indicator Select if you do not want the shipment to be left in a safe location for the recipient 

(e.g.  between front doors) when nobody is present to accept the delivery. 
Card for Pickup Indicator Select if you would like a card left so that the recipient can pick up the shipment at a 

postal counter. 
Proof of Age Required (18) Select to indicate that the item is delivered once the proof of age (18) has been 

verified. 
Proof of Age Required (19) Select to indicate that the item is delivered once the proof of age (19) has been 

verified. 
Leave at Door Indicator Select to have the mail carrier leave the parcel at the destination address if the 

recipient is not present (rather than leave a card indicating a delivery attempt). 
Registered Indicator Select to have the shipment sent by Registered Mail, typically used to send 

important items that require proof of mailing and/or proof of delivery. 
Special Delivery Indicator Select to have the shipment sent Special Delivery, which helps expedite mail 

delivery. 
Advice of Receipt Indicator For U.S. shipments, select to receive a signed card from the recipient acknowledging 

receipt of the shipment. 
Email Notification Indicator Select to indicate that you are notifying your customer via e-mail 
Insured Amount Enter an amount to select the coverage option and have that amount of insurance 

applied to the shipment. 
COD Amount Enter an amount to select the COD option and have that amount collected upon 

delivery. 
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Method of Collection Select the required method of collecting the COD amount:   
Cash 
Cash or cheque 
Post-dated cheque. 

Evening Delivery (6 p.m. – 9 p.m.) Select to indicate that the item is delivered between 6 P.M. and 9 P.M. during the 
week  

Saturday Delivery (9 a.m. – 1 p.m.) Select to indicate that the item is delivered between 9 A.M. and 1 P.M. on Saturday 
Pick Up @ The Post Office Select to indicate that the item should be picked up at the post office 
Notification Method  
Deliver to Door Select to indicate that the item should be delivered to the door 
Deliver to Parcel Box Select to indicate that the item should be delivered to the parcel box 
Card Notification Only  
 
Size & Weight Tab 
 

 
 

Size and Weight Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Size & Weight Tab 
Weight The weight, in grams, of the package to be shipped for this order item. 

 
Note:  The Weight field on the Ship tab of the Shipping window is in kilograms. 

Length The length, in millimeters, of the package to be shipped for this order item.  Should 
also enter the width and height. 

Width The width, in millimeters, of the package to be shipped for this order item.  Should 
also enter the length and height. 

Height The height, in millimeters, of the package to be shipped for this order item.  Should 
also enter the length and width. 
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Customs Tab 
 

 
 
 

Customs Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Customs Tab 
Customs Currency* Acronym of the currency used to define dollar amounts - such as USD. 
Customs Value Total declared value of the goods for Customs purposes.  Only needs to be supplied 

when goods are not individually supplied (i.e. total cannot be calculated). 
Duty and Tax Total Duty and Taxes to apply to the shipment. 
Reference Number User reference information to print on the Customs document. 
General Description General description of the shipment to print on the Customs document, when 

individual goods are not printed (such as the Purolator Bill of Lading). 
Additional Information Additional Customs Information to print on the Commercial Invoice. 
Reason for Export* Valid codes are: 

• DOC for Document 
• GIF for Gift 
• OTH for Other/Not Applicable 
• REP for Repair Warranty 
• SAM for Commercial Sample 
• TRD for Trade Show 

Reason for Export Comment Used to define the reason for export when Reason for Export = Other. 
Non-Delivery Instructions  Valid codes are: 

• RETAIR for Return via Air 
• RETSUR for Return via surface 
• TREABA for Treat as Abandoned 

Country of Origin The Country of Origin of goods to be displayed on the Customs document when only 
one can be printed (as opposed to printing the one for each individual goods in the 
shipment). 

Province of Origin The Canadian Province of Origin of goods to be displayed on the Customs 
document when only one can be specified. 
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Goods Tab 
 

 
 
 
 
 

Goods Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Goods Tab 
Item/Part/SKU # Identifies a code for the item. 
Quantity* Identifies the quantity of the good. 
Description Identifies a description for the item. 
Unit Weight Identifies a weight (in grams) for the individual item. 
Customs Value Identifies the value for the item for customs purposes. 
Tariff Code Identifies the tariff code for the item based on the origin of the goods. 
 
Command Buttons 
 
 
 
 
Click this button to access the Maintain Imported Order Items window to modify the data of this Imported Order Item. 
 
 
 
Click this button to access the Goods window to pre-define or to fully define the imported goods that you want to add. 
 
 
 
 
Click this button to remove the currently displayed Imported Order Item. 
 
 
 
This button is enabled when either new data has been entered or a change has been made to existing data.  It clears the three 
Maintain Imported Order Items of all data to make them ready for a new record.  You are returned to the Client Info tab. 

Save 

Delete 

Add 

Edit 
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Click this button to display the previous Imported Order Item if multiple ones have been selected for editing. 
 
 
 
Click this button to display the next Imported Order Item if multiple ones have been selected for editing. 
 
 
 
 
Click this button to exit the Maintain Imported Order Items window.  If new data has been entered or a change has been made to 
existing data, then a Yes/No/Cancel confirmation pop-up window appears asking you if you want to save your changes. 

6.2 Cost Centers 
 
Select Cost Centres to access the Cost Centres window, where you can import cost centre names to the list or create new names 
to be used by the application. 
 
Access this window by selecting Cost Centres from the Data Maintenance menu or from the drop down menu of the Cost Centre 
field on the Ship To section of the Shipping window. 
 

 
 
Overview 
Cost Centers are used to allocate the costs of shipping transactions.  Use the Cost Centers window to maintain a list of user-
defined Cost Centers (i.e. adding and deleting Cost Centers to the list, and modifying the names of existing Cost Centers). 
 
If there are any Cost Centers in the list for the selected  Mailed On Behalf Of Customer, the initial focus is on the first Cost Centre 
in the list. 
 
You can import Cost Centre information produced outside of Electronic Shipping Tools by using the Import button on the Cost 
Centers window. 
 
Duplicates are filtered from the Cost Centre List, which is sorted alphabetically. 
 
Once a Cost Centre is associated to a shipment, it cannot be deleted from the list. 
 
Format for files The import file must be line-separated (i.e. carriage return – CR, line feed – LF).  Enter one Cost Centre Name per 
line.  The system loads the first 40 characters up to the carriage return/line feed, or every line in the file.  No parsing is edits are 
made on the data you provide.  Any special characters leading, embedded, or following the Cost Centre Name will be loaded into 
the application database without being edited by the application. 
 

< 

> 

Close 
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Cost Centers  
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

For Mailed On Behalf Of Customer Defaulted to the currently selected Mailed On Behalf Of customer numbers.  
The drop-down list is populated with all of the Mailed On Behalf Of customer 
numbers that are configured on your desktop application.  Select the one 
whose Cost Centre List you wish to view/modify. 

Cost Centre List A complete list of currently defined Cost Centers for the selected Mailed On 
Behalf Of customer number. 

Cost Centre Name * The name of the Cost Centre currently highlighted in the Cost Centre List.  
To add a new Cost Centre, click New, enter the name in this field, and then 
click Save. 

 
Command Buttons 
 
 
 
 
Click this button to import a file of Cost Centre information.  The Open File – Import Cost Centre window appears, which is a 
standard Window file location window.  Follow the prompts to locate the desired file.  Once you have selected a file, an OK/Cancel 
confirmation pop-up window appears, asking if this is the correct file to import for the displayed CPC Customer Number (i.e. Mailed 
On Behalf Of Customer Number). 
 
 
 
 
Click on a Cost Centre in the list to select it.  This button becomes enabled.  Click it to remove the Cost Centre.  A Yes/No 
confirmation pop-up window appears. 
 
Note:  Once a Cost Centre is associated to a shipment, it cannot be deleted from the list. 
 
 
 
 
To add a Cost Centre to the list, you MUST click this button.  Focus disappears from the Cost Centre List and the Cost Centre 
Name field is cleared. 
 
ATTENTION!  DO NOT type over a Cost Centre Name in that field.  This actually modifies the name of the highlighted Cost Centre. 
 
 
 
 
This button becomes enabled once you type in the Cost Centre Name field (either after clicking New or for modification).  Click it to 
save the current Cost Centre Name. 
 
 
 
 
Click this button to exit the Cost Centers window. 

6.3 Address Book 
 
Select Address Book to access the Address Book window, where you can create address books, add/delete recipients to/from 
address books, and edit address book entries. 
 
Access this window by selecting Address Book from the Data Maintenance menu. 
 

Import 
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Save 

Close 
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Overview 
Address Book’s functionality allows you to group customers with similar shipping characteristics. Your Address Book acts as your 
main database of addresses, from which you can select addresses to ship to, or create distribution lists for group shipping. Use the 
Address Book window to organize your customers into address books (either all in one address book, or in multiple address 
books).  Also use the Address Book window to add, delete, or edit clients in Address Books. 
 
You can import existing address books into Electronic Shipping Tools using the Import button on the Address Book window. 
 
ATTENTION!  When you import client information into the application database, City initially sorts the records in the Client List 
frame.  You can change the sorting criterion by clicking on the desired column heading.  However, once any action is taken, such as 
a deletion or modification, the sorting criterion reverts back to City. 
 
The initial focus is on the Address Book Name field. 
 
Client window frame 
 

 
 
The following are observations about this window when accessed via the Address Book window: 

1. When you click the Add button on the Address Book window, the Client window appears with Cancel, not Delete, as 
the first command button. 

2. When you click Cancel on the Client window and then click No, the Cancel button changes to Delete. 
3. When you click the Edit button on the Address Book window after selecting a client record, the Client window appears 

with Delete, not Cancel, as the first command button. 
 
Format for files: The import file must be a comma-delimited ASCII flat file where character and non-integer numeric fields are 
enclosed in double quotes (“).  Where no information is available, you need not enter a blank entry (i.e.  “”),  EXCEPT if it is the last 
field. 
 
You are responsible for providing the proper province, state, and country codes.  These fields will be validated by the application 
during the processing of a shipment. 
 



 

©June2005 Canada Post Corporation  44 

 

Click here if you are reading this guide online to view the Address Book File Structure.  If not, please visit the Canada Post website 
(www.canadapost.ca) > Business > select Electronic Shipping Tools from the Shipping and Delivery drop-down list > Benefits and 
Features (at right) > click on Distribution at bottom > Address Book more… > Address Book Import File Specifications. 
 
Below the Address Book File Structure and given samples, click on “one file” to access a document of valid provincial, state, and 
country codes.  If you are reading this guide online, click here. 
 

Address Book  
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

For Mailed On Behalf Of Customer Display-only.  Identifies the currently selected Mailed On Behalf Of customer 
number. 

Address Book Name Use this drop-down list to select from the existing Address Books in the 
application for the currently selected Mailed On Behalf Of customer number.  If the 
list is blank, no Address Books have been created yet. 

Search Fields Enter the search criterion in the Search for field and select the appropriate column 
heading in the drop-down list. 

 
Command Buttons 
 
(Following three buttons are located within the Address Book frame) 
 
 
 
 
Use this button to delete an entire Address Book and all of the clients associated with it.  Select the desired Address Book from the 
Address Book Name drop-down list and click this button.  A Yes/No confirmation pop-up window appears. 
 
 
 
Click this button to import client information in the form of a file created outside of Electronic Shipping Tools.  The Open File – 
Import Address Book pop-up window appears, which is a standard Window file location window.  It is defaulted to the location of 
the file of the last successful import.  Follow the prompts to locate and import the desired file. 
 
 
 
 
Click this button to access the Address Book pop-up window, where you can enter an Address Book Name to create a new, blank 
Address Book.  Click OK to create it.  The Address Book Name field becomes populated with the new name. 
 
(Following four buttons are located within the Client frame) 
 
 
 
 
Even though this button is enabled even with no search criterion entered, the Find functionality does not return records with blank 
entries in the selected column heading.  You can search on the following fields:  Client ID, First Name, Last Name, Title, Company, 
Address Line 1, Address Line 2, City, Province/State, Country, Postal/Zip Code, and Phone Number.  The Find functionality is not 
case-sensitive.  Select the appropriate column heading from the drop-down list to the left of this button, enter the search criterion, 
and then click this button.  Only those client records that match the search criterion are displayed in the Client List frame. 
 
ATTENTION!  A search on the Client ID, Last Name, and Company fields requires an exact match.  The other search fields support 

partial searches. 
 
Note:  To list ALL client records again after doing a search, you must reselect the Address Book in the Address Book Name field. 
 
 
 
Click this button to access the Client window to add a new client to the currently selected Address Book.  If a name has been 
selected in the Address Book Name field, the Address Book field on the Client window defaults to this name. 
 
 
 
 
Click on a client record in the Client List frame to select it and click this button to modify it.  The Client window appears. 
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You can also double-click on the client record to access the Client window for modification. 
 
 
 
 
Click on a client record in the Client List frame to select it and click this button to remove it from the currently selected Address 
Book.  An OK/Cancel confirmation pop-up window appears. 
 
Following button is at bottom right of the window. 
 
 
 
 
Click this button to exit the Address Book window. 

6.4 Group Shipping of Clients 
 
 Click on Group Shipping of Clients button to access the Group Shipping List – Clients window, where you create and edit (i.e. add, 
delete, and modify entries) distribution lists of clients. 
 

 
 
Overview 
 
A Group Shipping List allows you to group together customers sharing similar shipping requirements. Group Shippings are 
temporary mailing lists that target specific mailings to a particular group of customers.   
 
Use the Group Shipping pop-up window to group customers from different address books and your imported order items into 
convenient distribution lists, allowing you to send similar shipments to multiple addresses. 
 
The Group Shipping function allows you to process shipments very quickly, and saves you valuable processing time. 
 
Note:  To use Group Shipping, you must be sending identical mailings (i.e. mailings that have identical size and weight attributes) 

to multiple recipients. 
 
ATTENTION!  Contrary to the Address Book window, you cannot use the <CTRL> and <SHIFT> keys to select multiple client 
records for deletion. 
 
Since there is no Edit button on this window, you need to double-click on a client record to access the Client window for 
modification of the record. 
 
Clients window frame lists all clients in the currently selected distribution list. Click the headings on the list to sort the list by that 
category (the selected category is enclosed by asterisks).  Double-click an item on the list to view and edit that item. 
 

Group Shipping List - Clients 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Clients List of all available Group Shipping Lists of Clients for the current Mailed on Behalf 

Delete 

Close 
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of Customer.  Note that the Group Shipping Lists of Clients should not be 
displayed if there are no records assigned to it. 
One of Clients Group Shipping List or Imported Orders Group Shipping List must 
be entered for a Group Shipping process. 
Disabled if an Imported Orders Group Shipping List has been selected. 

Imported Orders List of all available Group Shipping Lists of Imported Orders. Note that the Group 
Shipping Lists of Imported Orders should not be displayed if there are no records 
assigned to it. 
Disabled if a Clients’ Group Shipping List has been selected. 

Sort By List of possible sort criteria for the selected type of Group Shipping. The default 
sort criterion is ‘As Created’. In addition to the ‘As Created’ list value, the list is 
populated with the list found on the corresponding Group Shipping List window in 
the Search In drop down list (see P490U 1.2.05 Maintain Group Shipping List). 
The Sort By drop down list will be empty until a user selects a Client or Imported 
Orders Group Shipping List. It will be dynamically refreshed when the type of 
Group Shipping List selected is modified. 

 
Command Buttons 
 
If a Group Shipping List (Clients or Imported Orders) has been selected: 
 
Starts the processing of the Group Shipping List  
 
When processing Group Shipping Lists of Imported Orders: 
 
That have mutually exclusive options selected, the record should be processed with the first selected option and disregard 
subsequent options. 
 
Included options should be selected regardless of whether or not the record has these options selected. 
 
Pre-requisite options should be selected regardless of whether or not the record has these options selected. 
 
 
 
 
Closes the Group Shipping Pop-up window and returns to the Shipping window, in the state where it was before calling the Group 
Shipping function  
 
     Add Client to Group Shipping List 
 
 
 
 
This button is enabled only when Group Shipping is selected in the Group Shipping field.   
 
Access this window by clicking the Add button on the Group Shipping – Clients window. 
 

 
 

Close 

Add 



 

©June2005 Canada Post Corporation  47 

 

Use this window to add client records from Address Books to the Distribution List selected on the Group Shipping – Clients 
window.  The initial focus is on the Address Book field. 
 
Note:  To list ALL records in a selected Address Book, click Search with no criterion entered in the Search Criteria frame.  You can 

do this even if there is a criterion entered in the Search for field of the Search Results frame. 
 
You can select multiple client records in the Search Results and Selected Clients frames.  To select a block of successive 
client records from the list, click on the first record, hold down the <SHIFT> key, and click on the last record.  The block 
becomes highlighted.  To select non-adjacent records, hold down the <CTRL> key while you click on the individual records. 

 
Command Buttons 
 
 
 
 
The Search functionality works only when an Address Book is selected from the Address Book drop-down list.  Use this button to 
list client records in the Search Results frame.  To list ALL records from that Address Book, do not enter any search criteria and 
click this button.  To filter the initial listing, use the four search fields available:  City, Prov/State, Country, and PC/ZIP. 
 
Initially, the Prov/State drop-down list is blank.  If the Country selected is Canada, then the Prov/State field becomes populated 
with an alphabetical listing of the valid provinces and territories.  If the Country selected is USA, then the Prov/State field becomes 
populated with an alphabetical listing of the valid states.  Also, the PC field changes to ZIP. 
 
Both the City and PC/ZIP fields support partial searches.  However, if you are entering part or all of a Postal Code, it must be in 
capital letters. 
 
 
 
 
Once there are client records listed in the Search Results frame, use this button to further filter the list.  This button is enabled 
when a search criterion is entered.  The Find functionality is not case-sensitive.  The available search fields are as follows:  Client 
ID, First Name, Last Name, Title, Company, Address Line 1, Address Line 2, City, Province/State, Country, Postal/Zip Code, and 
Phone Number. 
 
Note:  All the search fields support partial searches.  Furthermore, a match is identified if the search criterion is found anywhere in 

the field value.  For example, if you enter “n” and select First Name as the search field, all records with “n” anywhere in the First 
Name (not just as the first letter) are returned. 

 
If there are no matches to the search criterion, all records are cleared from the Search Results frame. 
 
 
 
This button becomes enabled when one or more client records are selected in the Search Results frame (use the <CTRL> and 
<SHIFT> keys to select multiple records).  Click it to move the record(s) to the Selected Clients frame. 
 
You can also double-click on a client record to move it from the Search Results frame to the Selected Clients frame. 
 
 
 
This button becomes enabled when one or more client records are selected in the Selected Clients frame (use the <CTRL> and 
<SHIFT> keys to select multiple records).  Click it to move the record(s) to the Search Results frame. 
You can also double-click on a record to move it from the Selected Clients frame to the Search Results frame. 
 
 
 
This button becomes enabled when the Search Results frame contains client records.  Click it to move ALL listed records to the 
Selected Clients frame. 
 
 
 
 
This button becomes enabled when the Selected Clients frame contains client records.  Click it to move ALL listed records to the 
Search Results frame. 
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Click this button to add the client records in the Selected Clients frame to the Distribution List.  The Add Client to Group Shipping 
List window is automatically closed and you are returned to the Group Shipping– Clients window, with the new records appearing 
in the Clients frame. 

6.5 Group Shipping List of Imported Orders  
 
Select Group Shipping List of Imported Orders to access the Group Shipping List  - Imported Order Items window, where you 
can create and edit (i.e. add, delete, and modify imported order items) distribution lists. 
 
Access this window by selecting Group Shipping of Imported Orders from the Data Maintenance menu. 
 

 
 
Overview 
Use this window to prepare a Group Shipping List of Imported Orders.  Imported Order Items can be created manually using the 
Maintain Imported Order Item window tabs or imported from external sources using the Open File – Import Order Items window. 
 
The Imported Order Items frame lists all the Imported Order Items in the Group Shipping List currently selected in the Group 
Shipping Name field. 
 
The initial focus is on the Group Shipping Name field. 
 
ATTENTION!  Contrary to the Address Book window, you cannot use the <CTRL> and <SHIFT> keys to select multiple client 

records for deletion. 
 
Since there is no Edit button on this window, you need to double-click on an Imported Order Item record to access the 
Maintain Imported Order Item window for modification of the record. 

 
Note that you cannot create group shipping lists that include both Imported Order Items and Clients. 
 

Group Shipping List - Imported Order Items  
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

For Mailed On Behalf Of Customer Display-only.  Identifies the currently selected Mailed On Behalf Of customer 
number. 

 Group Shipping Name Use this drop-down list to select from the existing Imported Orders Group 
Shipping Lists in the application for the currently selected Mailed On Behalf Of 
customer number.  If the list is blank, no Group Shipping Lists have been created 
yet. 

Search Fields Enter the search criterion in the Search for field and select the appropriate column 

Apply 
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heading in the drop-down list. 

 
Command Buttons 
 
(Following three buttons are located within the Group Shipping frame) 
 
 
 
 
Use this button to delete an entire Group Shipping, and all of the clients associated with it.  Select the desired Group Shipping from 
the Group Shipping Name drop-down list and click this button.  A Yes/No confirmation pop-up window appears. 
 
 
 
 
Click this button to access the New Group Shipping pop-up window, where you can enter a Group Shipping Name to create a 
new, blank Group Shipping List.  Click OK to create it.  The Group Shipping Name field becomes populated with the new name. 
 
 
 
 
With a Group Shipping List highlighted in the Group Shipping Name drop-down list, click this button to change its name.  
 
(Following four buttons are located within the Imported Order Items frame) 
 
 
 
 
Even though this button is enabled even with no search criterion entered, the Find functionality does not return records with blank 
entries in the selected column heading.  You can search on the following fields:  Order ID/Reference #1, Client ID, First Name, Last 
Name, Title, Company, Additional Address Info, Address Line 1, Address Line 2, City, Province/State, Postal/Zip Code, Country, 
Voice Phone Number, Weight, Article (representing Service Type), Length, Width, Height, COD Amount, and Method of Collection.  
The Find functionality is not case-sensitive.  Select the appropriate column heading from the drop-down list to the left of this button, 
enter the search criterion, and then click this button.  Only those client records that match the search criterion are displayed in the 
Clients frame. 
 
ATTENTION!  A search on the Client ID, Last Name, and Company fields requires an exact match.  The other search fields support 

partial searches. 
 
 
 
 
This button is enabled only when Group Shipping is selected in the Group Shipping Name field.   
 
 
 
 
Click on an Imported Order Item record in the Imported Order Items frame to select it and click this button to remove it from the 
currently selected Distribution List.  A Yes/No confirmation pop-up window appears. 
 
(Following button is at bottom right of the window) 
 
 
 
 
Click this button to exit the Imported Orders Group Shipping List window. 

Delete 

New 

Edit 

Find 

Add 

Delete 

Close 



 

©June2005 Canada Post Corporation  50 

 

 
     Add Imported Order Item to Group Shipping List 
 
 
 
 
This button is enabled only when Group Shipping is selected in the Group Shipping Name field.  Access this window by clicking 
the Add button on the Imported Order Group Shipping List window. 
 

 
 
Overview 
 
Use this window to add Imported Order Item records available in the application database to the  Group Shipping selected on the 
Imported Order Group Shipping List window.  
  
The initial focus is on the Address Book field. 
 
Note:  To list ALL records in the application database, click Search with no criterion entered in the Search Criteria frame.  You can 

do this even if there is a criterion entered in the Search for field of the Search Results frame. 
 
You can select multiple client records in the Search Results and Selected Orders frames.  To select a block of successive 
client records from the list, click on the first record, hold down the <SHIFT> key, and click on the last record.  The block 
becomes highlighted.  To select non-adjacent records, hold down the <CTRL> key while you click on the individual records. 

 
Command Buttons 
 
 
 
 
Use this button to list Imported Order Item records in the Search Results frame.  To list ALL records from in the application 
database, do not enter any search criteria and click this button.  To filter the initial listing, use the four search fields available:  City, 
Prov/State, Country, and PC/ZIP. 
 
Initially, the Prov/State drop-down list is blank.  If the Country selected is Canada, then the Prov/State field becomes populated 
with an alphabetical listing of the valid provinces and territories.  If the Country selected is USA, then the Prov/State field becomes 
populated with an alphabetical listing of the valid states.  Also, the PC field changes to ZIP. 
 
Both the City and PC/ZIP fields support partial searches.  However, if you are entering part or all of a Postal Code, it must be in 
capital letters. 
  
 
 
 
Once there are client records listed in the Search Results frame, use this button to further filter the list.  This button is enabled 
when a search criterion is entered.  The Find functionality is not case-sensitive.  The available search fields are as follows Order 
ID/Reference #1, Client ID, First Name, Last Name, Title, Company, Additional Address Info, Address Line 1, Address Line 2, City, 
Province/State, Postal/Zip Code, Country, Voice Phone Number, Weight, Enhanced Record Indicator, Article (representing Service 
Type), Length, Width, Height, Document Indicator, Delivery Confirmation Indicator, Oversize Indicator, Signature Indicator, US 
Postal Box Indicator, Do Not Safe Drop Indicator, Card for Pickup Indicator, Proof of Age Required (18) Indicator, Proof of Age 
Required (19) Indicator, Leave at Door Indicator, Registered Indicator, Special Delivery Indicator, Advice of Receipt Indicator, 
Prepaid Indicator, Insured Amount, COD Amount, Method of Collection, Scheduled Delivery Instructions (English), and Scheduled 
Delivery Instructions (French). 
 

Add 

Search 

Find 
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Note:  All the search fields support partial searches.  Furthermore, a match is identified if the search criterion is found anywhere in 
the field value.  For example, if you enter “n” and select First Name as the search field, all records with “n” anywhere in the First 
Name (not just as the first letter) are returned. 

 
If there are no matches to the search criterion, all records are cleared from the Search Results frame. 
 
 
 
This button becomes enabled when one or more Imported Order Item records are selected in the Search Results frame (use the 
<CTRL> and <SHIFT> keys to select multiple records).  Click it to move the record(s) to the Selected Orders frame. 
You can also double-click on an Imported Order Item record to move it from the Search Results frame to the Selected Orders 
frame. 
 
 
 
This button becomes enabled when one or more Imported Order Item records are selected in the Selected Orders frame (use the 
<CTRL> and <SHIFT> keys to select multiple records).  Click it to move the record(s) to the Search Results frame. 
You can also double-click on a record to move it from the Selected Orders frame to the Search Results frame. 
 
 
 
This button becomes enabled when the Search Results frame contains Imported Order Item records.  Click it to move ALL listed 
records to the Selected Orders frame. 
 
 
 
 
This button becomes enabled when the Selected Orders frame contains Imported Order Item records.  Click it to move ALL listed 
records to the Search Results frame. 
 
 
 
 
Click this button to add the Imported Order Item records in the Selected Orders frame to the Group Shipping.  The Add Imported 
Order Item to Distribution List window is automatically closed and you are returned to Imported Orders Group Shipping 
window, with the new records appearing in the Imported Order Items frame. 
 
 
 
 
Click this button to exit the Add Imported Order Item to the Group Shipping window.  If there are Imported Order Item records in 
the Selected Orders frame, a Yes/No confirmation pop-up window appears, asking you if you want to save your changes.  If you 
click Yes, these records are added to the Group Shipping, and the Add Imported Order Item to Group Shipping window is 
automatically closed, returning you to the Imported Orders Group Shipping List window.  If there are no selected Imported Order 
Item records, then you just exit the window. 

6.6 Containers 
Select Containers to access the Containers window, where you can predefine container sizes and weights. 
 
Access this window by selecting Containers from the Data Maintenance menu or from the Ship To section of the shipping page. 
 

 

> 

< 

>> 

<< 

Apply 

Cancel 
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Overview 
 
To ease the periodic shipping of same type of package, use the Containers window to predefine the dimensions of your package. 
 
Use the Containers window to add a new shipping container type to the Container List, remove existing containers, or modify the 
properties of existing containers. 
 
Once the Container profile is created, all you have to do is select it in the Size & Weight frame of the Ship tab of the Shipping 
window to populate the weight and size fields.  This function can save you valuable time, avoid duplicate data entry and help ensure 
parcels get properly rated according to their size and weight. 
 
Command and Navigation Control Definitions 
 
The following table describes the fields and Command Button 
 

Containers 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Container List  A complete list of currently defined containers, indicating the name and dimensions. To 
modify the information for any container on the list, highlight the container, modify the 
appropriate fields, then click the Save button. 

Delete Click Delete to delete the container currently selected on the Container List. You will be 
prompted to confirm the deletion. 

Name* The name of the currently selected container (or blank, if no container is currently 
selected or you are adding a new container). To change or add a name, modify this field, 
then click the Save button. 

Weight The weight of the currently selected container (or 0, if no container is currently selected or 
you are adding a new one). The units of measure for this dimension are set using the 
Options tab of the Site Information window. To change or add a weight, modify this field, 
then click the Save button. 

Length* 
 

The length of the currently selected container (or 0, if no container is currently selected or 
you are adding a new one).  The units of measure for this dimension are set using the 
Options tab of the Site Information window.  To change or add a length, modify this field, 
then click the Save button. 

Width* The width of the currently selected container (or 0, if no container is currently selected or 
you are adding a new one). The units of measure for this dimension are set using the 
Options tab of the Site Information window. To change or add a width, modify this field, 
then click the Save button. 

Height* The height of the currently selected container (or 0, if no container is currently selected or 
you are adding a new one). The units of measure for this dimension are set using the 
Options tab of the Site Information window. To change or add a height, modify this field, 
then click the Save button. 

Cancel  Clears the fields and/or changes nothing 
Save Click Save to save your changes to the Electronic Shipping Tools database. 
Close Click this button when you are done on this window. 

6.7 Pre-defined Goods 
Select Pre-defined Goods to access the Pre-defined Goods window, where you can create predefined records of commonly 
shipped items so that you can quickly build a detailed description list of a shipment for customs purposes. 
 
Access this window by selecting Pre-defined Goods from the Data Maintenance menu. 
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Overview 
The Pre-defined Goods window is used to create pre-defined records of commonly shipped items. Each record describes a single 
item that can be included in a shipment. 
 
When you create a detailed description of a shipment for customs purposes, you can quickly build a list by selecting from these pre-
defined items. Most fields are optional, and later you can edit the value of any field after it has been included in the shipment. 
 
To simplify the completion of Customs information, select from the drop-down list the description of goods that have been pre-
defined using the Pre-defined Goods window 

6.8 Contract Number Alias 
 
Access this window by selecting Contract Number Alias from the Data Maintenance menu. 
 

 
 
Overview 
 
Use the Contract Number Alias window to associate an alias or alternate name to an existing contract. Using an alias name can 
make contract type identification easier during shipping.  This feature is especially useful when multiple people are accessing 
multiple contracts on the system, such as in a mailroom scenario.   
 
Select the Contract Number Alias you created from the Contract drop down list in the Charge To section of the Shipping window. 
 
The Alias Name is associated with the Contract Number. The Contract Number List details all currently defined contract 
numbers for the selected Customer Number. As each number is highlighted, the associated alias is displayed in the Alias Name 
field, if an alias has been defined. If an alias has not been defined, the Alias Name field is blank.   
 
To enter an alias, key the alias into the Alias field, then click Save. 
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Contract Number Alias 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Contract Number Field This list details all currently defined contract numbers for the selected CPC Customer #. 
As each number is highlighted, the associated alias is displayed in the Alias field, if an 
alias has been defined. If an alias has not been defined, the Alias field is blank. 

Alias Name This field displays the alias defined for the currently selected contract number. If no alias 
has been defined, this field is blank. To define an alias, enter it in this field. 

Contract Number List of all Contracts available to all Behalf of Customer Partners of the current Mailed By 
Customer. 

Customer Number Behalf of Customer Number associated to the Contract. 
Alias* Enter the user defined alias in this field 
Save Click Save to save your changes to the Electronic Shipping Tools database. 
Close Click this button to close this window. 

6.9 Salutations 
Access this window by selecting Salutations from the Data Maintenance menu. 
 

 
 
Overview 
A salutation is the title we use to address an individual, for example, Mr., Mrs., Dr., Ms, etc. Use the Salutations window to view all 
of the salutations currently available on the system. You can also create new salutations, or delete or modify existing salutations. 
 
The titles maintained in the Salutations window populate the drop-down list in the Ship To sectionof the Shipping window.  These 
salutations also populate the Title drop-down list in the Client window where client profiles are maintained and associated to an 
address book.  
 
Selecting Titles from a drop-down list makes shipping faster and ensures consistency for addressing standards. 
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Salutations 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Salutation List  A complete, alphabetical list of currently defined salutations by name. 

To modify the information for any salutation on the list, highlight the salutation, modify the 
Name field, then click Save. 

To add a new salutation, click New. 
Delete Highlight a salutation on the Salutation List, then click Delete to delete it. You will be 

prompted to confirm the deletion. 
New To add a new salutation, click New. Then, enter the name of the new salutation in the 

Name field and click Save. 
Name The name of the currently highlighted salutation. For a new salutation, this field will be 

blank. Click New, enter the name of the new salutation, then click Save. 
Save After any modification to the Name field (either the addition of a new name or the 

modification of an existing name), click Save to save your changes. 
Close Click this button when you are done on this window. 

6.10 Site Information 
The Site Information window has four tabs:  Machine Location, Outlets/Deposit Locations, Customers, and Options.  Much of the 
information in this window is pre-filled during set-up, or when the system downloads information from Canada Post. 
 
The Site Information window allows you: 
 
• To modify profile and/or configuration information of an existing Customers Site; 
• To maintain Machine Location Information; 
• To maintain Induction Point information; 
• To maintain a list of CPC Customer Information; 
• To maintain Site Options; and  
. 
Access this window by selecting Site Information from the Data Maintenance menu. 
 
  Machine Location Tab  
 
This tab will initially be populated using Canada Post information for the main CPC Customer. All subsequent changes will be 
managed locally.  The initial focus is on the Company field. 
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Overview 
The Site Information – Machine Location tab is used to record information about the physical address of the system. The address 
set up in the screen is used as the default return address on the manifest and label output. 
 

Machine Location Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Site This numeric field is display-only and cannot be altered by the user.  It is a unique, 
Canada Post-assigned number to identify the Electronic Shipping Tools site. 

Customer Owner This numeric field is the Mailed By Customer number, which is the Canada Post-
assigned customer number of the customer that is preparing the mailing.  It is the 
customer number associated with the login User ID.  It is display-only and cannot be 
altered by the user. 

Company * Enter your company name as it appears on your contract with CPC. 
Contact Enter the name of the primary contact person in your organization for CPC contracting 

issues. 
Address * Enter the street address of your organization as it appears on your contract with CPC. 
Address Line 2 Use this line if you need more space for the street address. 
City * Enter the city or municipality in which your organization resides. 
Country * From the drop-down list, select the country in which your organization resides (either 

Canada or USA). 
Province/State * If the Country is Canada, the field is Province and it displays an alphabetical listing of 

the valid provinces and territories.  If the Country is USA, the field is State and it displays 
an alphabetical listing of the valid states.  Select the province or state in which your 
country resides. 

PC/ZIP * If the Country is Canada, the field’s label is PC.  If the Country is USA, the field’s label is 
ZIP.  Enter the Postal Code or ZIP Code of your organization as it appears on your 
contract with CPC. 

E-Mail Enter the e-mail address of the primary contact person at your organization for CPC 
contracting issues. 

Phone (voice/FAX) * Enter the telephone number (in the left field) and/or fax number (in the right field) of the 
primary contact person at your organization for CPC contracting issues. 

Save Click the Save button to initiate the save process 
Close Click the close button to exit this window 
 
  Outlets/Deposit Locations Tab  
 
Access this window by selecting Site Information from the Data Maintenance menu. 
 

 
 
Overview 
The Site Information – Induction Point tab is used to record information about the Electronic Shipping Tools user. 
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To add or remove Outlets from the Outlet List, you must first click the Connect button and logon to the Electronic Shipping Tools 
server (if you have not already logged on).  If your local version of the application requires software or data updates, then you must 
initiate the software/data update process.  Only once the local version of the Electronic Shipping Tools application is up-to-date can 
the addition or removal of Outlets be processed. 
 
The Add button enables you to select an outlet from which to induct your mail.  Rating and services standards are based on the 
induction point selected in this window. 
The Remove button enables you to de-select an outlet.   
 
You may set up two default induction points: one for Shipping and Delivery Services and another for Communication services. 
 
 
 

Induction Point Tab 
COMMAND BUTTON OR MENU ITEM  RESULT OF INVOCATION 

Information Window This window displays basic information about CPC induction points. Select one to see 
more detailed information in the fields below. 

Outlet List  A unique, Canada Post Corporation name for the Outlets/Deposit locations used by the 
site. You cannot change this field. 

Outlet Display-only.  The postal facility where the mail is brought for induction into CPC’s mail 
stream.  Both the Outlet Number and Outlet Name are displayed in the Outlet List. 

Address Display-only.  The street address of the postal facility where the mail is brought for 
induction into CPC’s mail stream. 

PO Box Display-only.  The post office box of the postal facility where the mail is brought for 
induction into CPC’s mail stream. 

City Display-only.  The city of the postal facility where the mail is brought for induction into 
CPC’s mail stream. 

Province Display-only.  The province of the postal facility where the mail is brought for induction 
into CPC’s mail stream. 

Postal Code Display-only.  The postal code of the postal facility where the mail is brought for 
induction into CPC’s mail stream. 

Add Enables you to select an outlet from which to induct your mail.  Rating and Services 
standards are based on the induction point selected in this window. 

Remove Enables you to de-select an outlet. 
Connect Initiates the Logon process. 
Save Click the Save button to initiate the save process 
Close Click the Close button to exit this window 
 
  Customers Tab 
  
Access this window by selecting Site Information from the Data Maintenance menu. 
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Overview 
The Site Information – Customers tab is used to list all the Mailed on Behalf of partners and partner’s contracts that have been set-
up on the Electronic Shipping Tools. 
 
This tab also enables the user to add or remove Customer Numbers to the Mailed on Behalf of Customer List.   
 
To add or remove Customer Numbers to/from the Mailed On Behalf Of Customer List, you must first click the Connect button 
and logon to the Electronic Shipping Tools server (if you have not already logged on).  If your local version of the application 
requires software or data updates, then you must initiate the software/data update process.  Only once the local version of the 
Electronic Shipping Tools application is up-to-date can the addition or removal of Mailed on Behalf of Customers be processed. 
 

Customers Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Mailed By Customer Number This numeric field is display-only and cannot be altered by the user.  It identifies the 
Canada Post-assigned customer number of the customer that is preparing the 
mailing.  It is the customer number associated with the login User ID. 

Mailed By Contract Number This numeric field is display-only and cannot be altered by the user.  It identifies the 
number of the contract that the Mailed By Customer has with CPC. 

Customer Number (to be added to Mailed On 
Behalf Of Customer List) 

Enter the Mailed On Behalf Of Customer Number that you want to add to the 
application. 

Contract Number Enter the contract number of the Mailed On Behalf Of Customer Number to be 
added. 

Add Enables you to enter Customer Numbers to Mailed on Behalf Of Customer List 
Remove Enabled after you have clicked on the Connect button and successfully logged on 

to the Electronic Shipping Tools server; Removes the Customer Number from the 
Mailed on Behalf of Customer List. 

Connect Initiates the Logon process. 
Save If you select "Yes", then continues with the save process. If you select "No", the 

Save process is cancelled. 
Close Verifies if you have made changes to data. If you select "Yes", then you are 

prompted to save data prior to the window closing. If you select "No", the window is 
closed. 

    
  Options Tab 
 
Access this window by selecting Site Information from the Data Maintenance menu. 
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Overview 
The Site Information – Options tab allows you to maintain global settings which control added functionality for the application. This 
tab allows you to specify Options, System Preferences and Services Used.   
 
The checkboxes in the Options frame on this tab allows you to maintain global settings, which control added functionality for the 
application as follows:   
 

Options Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Options 
Language Select your preferred language from the drop-down list (English or French).  This 

choice will affect the default language of display for all Electronic Shipping Tools 
menus, screens, and messages.  This language choice can be overridden by 
language choices made on the User Profile window, if security is enabled. 

Security Enabled This option allows you to control access to the application.  Check it to use sign-in 
and sign-out security at the site. 

Inbound Freight Display-only.  This option is automatically checked by the system when a shipper is 
physically located in the US but inducts their mail in Canada.  The shipper’s country is 
set in the Machine Location tab.  You cannot change the value of this field. 

Automatically Initiate Printing of 
Unaddressed Admail Labels 

Check this option to automatically print labels for Unaddressed Admail.  This is for 
Communications Services only. 

Automatically initiate printing of 
Unaddressed Admail Container Labels 

Check this option to automatically print container labels for Unaddressed Admail. 

Enable PDF Format Printing Check this option to improve report, manifest, and label printing by loading a full 
version of the Adobe Acrobat Reader application. 

Services Used 
Communication Select this option if you want your desktop application to be configured to process 

Communications Services. 
Distribution Select this option if you want your desktop application to be configured to process 

Shipping and Delivery Services. 
Connect Initiates the Logon process. 
Save If you select "Yes", then continues with the save process. If you select "No", the Save 

process is cancelled. 
Close Verifies if you have made changes to data. If you select "Yes", then you are prompted 

to save data prior to the window closing. If you select "No", the window is closed. 
 

To modify the Services Used, you must first click on the Connect button and then logon to the Electronic Shipping Tools server (if 
you’re not currently logged on). Note that if your local version of the Electronic Shipping Tools application requires software or data 
updates, then you must initiate the software/data update process. Only once the local version of the Electronic Shipping Tools 
application is up-to-date can the addition or removal of Services Used be processed. 
 
 Command Buttons 
 

     
 
Access this window by either by clicking on the Shipping Preferences command button from the Site Information screen from the 
Data Maintenance Menu on the Desktop Window, or selecting the Shipping Preference menu on the Shipping Window. 
 
The Shipping Preferences window allows you to establish default settings for the application. 
 
This window is divided into four tabs:  Shipping, Shipping Options, Customs, and Return Parcel Data. 
 
ATTENTION!  Be sure to have the appropriate Mailed On Behalf Of customer number selected in the Default Settings for Mailed  
On Behalf Of field.  This field does NOT default to the currently selected Mailed On Behalf Of customer number. 

 
Shipping Tab 

 
Most of the following default settings affect the Ship To section of the Shipping window 
 
This illustration highlights the features of the Shipping tab.  

Shipping Preferences 
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Shipping Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Shipping Items Default Values 
Default Settings Mailed on Behalf Of Displays the Customer Number for which the mailing is being done 
Open Shipping Window on Startup Check this option to have the Shipping window automatically open when you 

enter the application. 
Prompt for Imported Order ID Check this option if you want an Imported Order ID supplied for every shipping 

transaction.  The prompt appears when you click the Process/Print button. 
Clear Shipping Data after Process/Print Check this option if you want the application to automatically clear the data 

entered in the Ship To and Size & Weight frames of the Ship tab (Shipping 
window) after processing a transaction. 
 
Note that the Cost Centre value and checkbox selections, if any, remain as is. 

Cost Centre Required Check this option to automatically include the cost centre to your shipping 
items 

Print USA/Intl Address Label Check this option to automatically print address labels for USA and 
International shipments. 

Additional Address Information required Check this option to automatically include additional address information to 
your shipping items  

Print Quickship Address Label Check this option to automatically print a label when using the Quickship 
option to process a parcel. 
 
Quickship normally suppresses the label printing, on the assumption that your 
label is produced using other means. 

PrintPostage Rate on International Labels Check this option if you want the postage rate displayed on the labels  
Print Insured Value on USA / Int’l Labels* Check this option if you want the insured value displayed on the labels 
Active Field after Process/Print 
Regular Shipment The system default is the Client ID field (i.e. after processing a regular 

transaction, the cursor is set in this field).  You can change this default to 
Imported Order ID, Last Name, or Company Name. 

Quickship Shipment The system default is the Country field (i.e. after processing a transaction 
using Quickship information only, the cursor is set in this field).  You can 
change this default to Postal Code. 

Measurement Units The system default for the preferred measurement unit is Metric.  You can 
change this default to Imperial. 

Cost Centre You can select a cost centre from the drop-down list to be automatically 
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associated with a shipment. 
No. of Pieces You can change the system default of “1” to a value not exceeding “999”. 
Container You can select a predefined container from the drop-down list to be 

automatically included in a shipment. 
Item Reference #2 You can enter a second reference number to help you manage your shipping 

process 
Use Cost Centre as Reference #2 Select this option to identify the Cost Centre as the second reference number 
Item Identifier 
Use System-Generated ID’s Select this option to have the application automatically generate an identifier 

(i.e. barcode) for shipments with delivery confirmation selected. 
Manually Scan/Type ID’s Select this option to have the responsibility of entering the identifier (i.e. 

barcode) for shipments with delivery confirmation selected.  If you do not enter 
one, the application prompts you for one when you click Process/Print. 

Manifest Address 
**Use Site Address Select this option to have Site address to appear on shipping labels 
**Use Customer’s Address Select this option to have Customer’s address to appear on shipping labels 
Address Label Return Address 
**Use Site Address Select this option to have Site address appear on return address labels 
**Use Customer’s Address Select this option to have Customer’s address appear on return address 

labels 
Save  Saves your information  
Close Click this button when you are done on this window. 
 
**You may select these default values to be printed on the manifest and/or return label. 
 

Shipping Options Tab 
 
The following default settings affect the Ship To, and Service and Options sections of the Shipping window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This illustration highlights the features under the Shipping Options tab.  
 
• Shipping Options Tab: This page allows you to select default values for your shipping options. For instance, the new Set 

command button allows you to select default values for options on shipments to Canada, the U.S. and international 
destinations 

 

Shipping Options Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Send E-Mail Notification? 
Client Check this option to send an E-Mail notification to the client 
Mailed By Check this option to send an E-Mail notification to the customer identified by the 

Mailed By number 
Mailed on Behalf Of Check this option to send an E-Mail notification to the customer identified by Mailed 

On Behalf Of number 
After Process/Print 
Clear Shipping Options Check this option to clear the service options selected for a Service Type between 

shipments per workstation.   
Retain Shipping Options Check this option to keep the service options selected for a Service Type between 

shipments per workstation.  You will get warning messages to remind you that this 
option is set. 
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Use default Service & Options - Set Check this option to use the service options selected for a Service Type between 
shipments per workstation 

Coverage 
Value You can enter a value to be the default amount if the Coverage service option is 

selected. 
COD 
Include Shipping Cost in COD Collection Amount Check this option which will includes the Shipping Cost to the COD amount to collect. 

COD Collection Amount You can enter a value to be the default amount if the COD service option is selected. 
COD Method of Collection You can select from the drop-down list a default method if the COD service option is 

selected. 
 
Customs Tab  

 
The following default settings affect the Customs tab.   
 

 
 

Customs Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Always print Customs document Check this option to print Customs documents for every order 
Retain Customs Data Check this option to have the application keep the customs data, including the goods 

selected, between shipments per workstation.  Remember that the Service Type field 
defaults to what was chosen for the previous transaction for a particular Country 
(Canada, USA, or International).  Once you change this Service Type, however, the 
customs data is permanently cleared (i.e.  you cannot retrieve it by reselecting the 
Service Type). 

Reference Number You can enter a reference number to be automatically associated to a shipment. 
CAD to USD The values of all predefined goods and those entered for one-time use via the Maintain 

Goods window are in Canadian currency.  You can enter an exchange rate that will 
automatically be used to calculate the Customs Value in US currency if USD is entered 
as the Customs Currency. 

Currency You can enter a currency (e.g. CAD, USD) to be automatically used for a shipment. 
Duty and Tax You can enter the value of the calculated Duty rate plus the tax that applies to the item. 
Value You can enter a customs value to be automatically used for a shipment.  This default 

applies only if the field is enabled for the Service Type chosen. 
Description You can enter a (general) description to be automatically used for a shipment.  This 

default applies only if the field is enabled for the Service Type chosen. 
Reason for Export 
•Gift 
•Commercial sample 
•Repair/Warranty 
•Trade show exhibit 
•Document 
•Other 

You can select a reason for export from the drop-down list to be automatically used for a 
shipment.   

Non Delivery Instructions You can select non-delivery instructions from the drop-down list to be automatically used 
for a shipment.  This default applies only if the field is enabled for the Service Type 
chosen. 
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Return Parcel Data Tab 
 
This illustration highlights the features found under the Return Parcel Data tab.  
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
Return Parcel Tab: This page allows you to select default values for use when a parcel is returned to you; it is related to the Print 
Return Label checkbox on the shipping page. This new page allows you to enter information that will be printed on the labels of 
designated returned parcels. You can also specify which type of service you wish to be used for the return, and an e-mail address 
for notification of a return. Once you click Save on this page, the information you have entered will appear on the return label if you 
choose to print one.  
 
You also have the ability to create return address labels to Group Shipping.  Enter the data that will be used to create the return 
label on the Return Parcel Data tab.   
 
This tab allows you to select various default settings: 
 

• Print Return Label checkbox 
• Use the Site Return Address for this Mailed on Behalf of Customer 
• Ship To fields 
• Return Parcel e-mail Notification field 
• Service Type (Domestic service only) 
• Always Use this Data for Return Parcels checkbox 

 
If you have checked the Print Return Label checkbox, the Return Label Information page is displayed when you click on  
the Process/Print button unless you have previously selected Always Use this Data for Return Parcels at the Default  
settings page.  Once you have selected the Process/Print button, the original label is printed, followed by the Return Address 
label. 
 
The cost information displayed on the Shipping page does not include the cost of returning the parcel.  This cost will be  
calculated when the parcel is mailed as a return and displayed on a separate line on your invoice.   
 
Please Note:  The Reports page now includes the new Returns report containing information on returned parcels based on the 
manifest number. 
 
The return labels option is disabled when you are working in Quickship mode. 
 

Return Parcel Data Tab 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Print Return Label Select this option if you want to print the Return Label 
Use the Address Label Return Address Select this option if you want the Return Address to be printed on your return label 
Use this Return Address The information you enter in this section will be used on the return address label 
Service Type Select service type from the drop down list 
E-Mail Notification? Enter the email address(s) to be used to send an E-Mail notification  
Always use this data for Return Parcels (Do 
not prompt during Process/Print) 

Select this option if you always want to use this data for your Return Parcel labels 

Save  If you select "Yes", then continues with the save process. If you select "No", the Save 
process is cancelled. 

Close  Click this button when you are done on this window. 
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Please click here for further details 

 
 
Please click here for further details 
 
 

 
Please click here for further details 

6.11 Customer 
 
The Customer window is where you identify your Mailed On Behalf Of customers to Electronic Shipping Tools. 
 
Access this window by selecting Customer from the Data Maintenance menu. 
 

 
 
Overview 
Use the Customer window to identify yourself to Electronic Shipping Tools. This window is completed during initial set-up of 
Electronic Shipping Tools.  Use the Customer window to maintain your default settings. 
 
The information in the Customer window overrides the information on the Machine Location tab of the Site Information window 
for the options selected in the these checkboxes. 

6.12 Client 
 
The Client window is where you can add and edit recipients. 
 
Access this window by selecting Client from the Data Maintenance menu. 
 

Printer Configuration 

Output Configuration 

Barcode Ranges 
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Overview 
Each Client entered in Electronic Shipping Tools has a profile that includes address and contact information, as well as the address 
book to which he/she belongs. Use the Client window to add a new Client and profile, or to edit an existing Client profile. 
 
The Client window is often used to leverage order taking in warehouse facilities.   
 
Select the Client record to populate the Ship tab of the Shipping window to expedite the shipping process and avoid duplicate data 
entry. 
 
Use the Search button to retrieve specific Client records. Enter search criteria in any or all of the Client ID, Last Name, and 
Company fields, and then click Search.  If these fields are left blank, all Clients are returned. If more than one Client matches the 
criteria entered, a list is presented in the Select Client window; select the appropriate Client from the list and click OK. 
 
The E-Mail field on the Client window captures the e-mail address for the Client.  This e-Mail address is the destination of a 
Shipment Notification to the Client when the Send e-Mail Notification checkbox is selected on the Service tab of the Shipping 
window. 
 
Each Client must be stored in an address book, but can be stored in only one address book. 
 
Client IDs are numbers you assign to each of your clients. They are optional, and can be used for any purpose you see fit, from 
simple organization to mapping the customer back to your own customer records in a meaningful way. Client ID numbers are added 
on the Client window. 

6.13 Import Presort Software Mailing Plan 
The Import Presort Software Mailing Plan window is used to import software mailing plans from an outside file.   

Note:  The Client Option refers to Shipping and Delivery Services.  For more information on its functions, please refer to the 
Shipping and Delivery Services User Guide.   
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6.14 Import Template 
 
The Import Template functionality is available on the Desktop version under the Data Maintenance menu header for Unaddressed 
Admail only.  For more information on its functions, please refer to the Unaddressed Admail User Guide. 
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7.0 Reports Menu 
 

 

7.1 Reports 
Access this window by selecting Reports from the Reports menu. 
 

 
 
Overview 
Reports provide you with reconciliation tools to manage your shipping business. 
 
The Electronic Shipping Tools reporting function allows you to produce and print many types of reports (detailed in the list below). 
Use the Reports window to select the report desired, enter the Criteria, then preview and print the resulting report. 
 
To generate a report: 
1. Select the report type from the Reports frame. 
2. Enter the criteria in the Criteria frame.  Criteria differ depending on the report selected. 
3. Click Preview to preview the report before printing. 
4.         Click Print to print the report. 
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Reports 
COMMAND OR 
MENU ITEM 

RESULT OF INVOCATION 

Date Range 
 

Enter a Start date and an End date. The resulting report will include only shipments that occurred within 
the specified date range. 

Client 
Information 

Enter Client ID, Last Name, and Company Name 

Preview Click Preview to view an on-screen preview of your report prior to printing. 
Print Click Print to print all of the messages displayed on the Communications Status screen. 
Close Click this button when you are done on this window. 
 
Report Names, Descriptions and Criteria Overview 
 
Client Detail Report lists the line items shipped to a specific customer. Report criteria include date range, client ID, and 
client/company name. 
 
Client Summary Report lists the total items shipped to a specific customer, summarized by service. Report criteria include date 
range, client ID, client name, and company name. 
 
COD Report lists all COD items shipped by a specific CPC customer. Report criteria include date range and CPC customer 
number.  This report enables you to manage the COD collection process after shipping. 
 
Cost Centre Detail – Manifest Report reports the value of each line item allocated to a specific cost centre. Report criteria include 
date range, CPC customer number, and cost centre.  This report enables you to manage the charge back of shipment fees by cost 
centre. 
 
Cost Centre Summary – Manifest Report reports the total value of shipping transactions for a specific cost centre, summarized by 
service. Report criteria include date range, CPC customer number, and cost centre. 
 
Credit Card - Manifest Report lists the manifests paid for by credit card.  Report criteria include date range and credit card type. 
 
Customer Detail Report reports the total value of shipping transactions for a specific CPC customer, for all of that customer's 
accounts. Report criteria include date range and CPC customer number. 
 
Customer Summary Report reports the total value of line items shipped for a specific CPC customer, summarized by service. 
Report criteria include date range and CPC customer number. 
 
Item Inquiry Report lists the delivery status of shipped items. Report criteria include manifest number and item reference. 
 
Manifest Report lists all closed manifests currently in the database. Report criteria include date range. 
 
Open Imported Order Report lists all outstanding orders from the order entry file, sorted by date, in a preview format. This report 
allows you to confirm that all the imported orders have been processed.  This report has no criteria. 
 
Parcel Return Report provides manifest information on parcel return orders.  Manifest number is required to initiate the query. 
 
Product Summary Report lists the total items shipped within a product category. Report criteria include date range and service. 
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7.2 Delivery Confirmation 
To access this window, select  Delivery Confirmation from the Reports menu. 
 

 
 
Overview 
You can use Electronic Shipping Tools to confirm delivery of domestically shipped items or groups of items. Use the Delivery 
Confirmation window to search for and confirm delivery of a single item, or all items that can be confirmed that are associated with a 
particular manifest.  Access this window by selecting Delivery Confirmation from the Reports menu 
 
For an item or manifest to appear in this window and be selected for confirmation, it must meet the following criteria: 
• It must have a delivery confirmation option. 
• It must have been transmitted to Canada Post. 
• It must not be voided. 
• It must not already have a final response status (i.e., successful delivery was previously confirmed). 
 
 
 

Delivery Confirmation 
COMMAND OR 
MENU ITEM 

RESULT OF INVOCATION 

Search Once you have entered criteria from the drop down menu, click Search to conduct the search.  Select 
from Company, Client Id, Item Identifier, Last Name, Manifest Number, or Imported Order Id. 

All Manifest 
Items 

Once the Search Results frame has been populated with all confirmable transactions allocated to a 
closed manifest by conducting the appropriate search (i.e., completing the Manifest # field and clicking 
Search), you can confirm delivery for all confirmable items on the manifest by invoking the overnight 
batch delivery confirmation process. 
Click Manifest. Electronic Shipping Tools will send a delivery confirmation request the next time you 
communicate with Canada Post. The request will return a description of the most significant event, the 
date of the event and the signatory name 

Event 
Description  

Click the Event Description command button to display a separate window that shows the complete 
Delivery Confirmation Description (which is up to 400 characters). 

Submit Select Submit to send information.  
Print Once Electronic Shipping Tools has received a response to either an item or manifest delivery 

confirmation request, the results are displayed on this screen. You can then click Print to print the results. 
Close Click this button to exit this window. 
 

 
 



 

©June2005 Canada Post Corporation  70 

 

 

8.0 Tools Menu 

 
 
Use the Tools menu to perform system functions and configure peripheral equipment used with Electronic Shipping Tools as 
follows: 

8.1 Search/Manage Orders Window 
 
The screen displayed below shows an example of a Shipping and Delivery Services screen, which has different functionality than 
Communications Business.  For the purposes of the application functionality, only the commands and features of the 
Communications Business are described.  
 

 
 
Overview 
This user interface component enables you to search for SOMs.  Selecting the Search/Manage Orders from the Tools menu triggers 
it.  From this window one can search for and retrieve Orders from the database and Open, Preview, Finalize, Transmit or Reprint the 
Order.  
 

1. The Search window allows you to search for and retrieve transactions using the following search criteria:  
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• Order Type; 
• Order Id 
• Mailed on Behalf of (Customer Number) 
• Status;  
• Creation Date; 
• Start Mailing Date; 
• End Mailing Date; and 
• Service Offering (displayed as Manifest Type in the screen below) 

 
Note: The Search Results column headings will only appear once the SOM search results are returned.  As well, the 
Details column headings and data will only appear once a SOM has been selected.  When more than one entry is 
selected from the Search Results table, the Details table is cleared, including column headings.  

 

2. You can enter one or more search criteria. 

3. If the Start Mailing Date is entered and the End Mailing Date is blank, search is performed on Transactions that have 
a Mailing Date greater than or equal to the Start Mailing Date. If the End Mailing Date is entered and the Start 
Mailing Date is blank, search is performed on Transactions that have a Mailing Date less than or equal to the End 
Mailing Date. 

4. When the Start Mailing Date and End Mailing Date search criteria are entered, the search is performed on the Order 
Details for SOMs that have the Downstream Entry checkbox selected (as opposed to at the header level). If at least 
one line item contains a Date of Mailing within the search criteria entered, the SOM is displayed in the Search 
Results pane. 

5. Transactions that match the input search criteria are listed in a data grid and are sorted by Order Id (SOM Id), then 
by local Id, in ascending order.  You can sort the list by different fields by clicking the title of the appropriate column 
in the Search Results and Details grids. 

6. The copies fields are defaulted with the value of 1. 

7. Multiple rows (i.e. items) can be selected in the Details pane for the purpose of deleting and reprinting items. 

8. The Search/Manage Orders window includes a status line at the bottom to display messages for processes that are 
not immediate, such as Transmit/Print. 

9. The Drop Down List for the Date fields is defined below: 

• You can select a date from a visual calendar component. 

• When a date is not specified in the applicable field, the Month, Year and Day are defaulted to the current 
date. 

• When a date is specified in the applicable field, the Month, Year and Day are set to the value entered in 
the field. 

• You can scroll sequentially through the Calendar Month values (January to December) or Year values by 
using the mouse to click on the up and down arrows buttons located adjacent to the month or Year labels. 

• Either clicking on the desired value or using the up/down/left/right arrow keys performs navigation through 
the Day values 

• Clicking on another field on the parent window closes the Calendar component and the date selected is 
returned to the date field.  To clear the date field, press the Esc 
key. 

• The specified date is returned and displayed in the date field 
when: 

• You double click on a particular day with the mouse; or 

• Use the mouse or arrow keys and press the Enter key.  
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Search/Manage Orders 
COMPONENT LABEL DESCRIPTION 

Search Criteria  
Order Type Search criterion 

Order Id Search criterion 

Mailed on Behalf of  Search criterion 

Status Search criterion 

Creation Date Search criterion 

Start Mailing Date Search criterion 

End Mailing Date Search criterion 

Service Offering Search criterion 

Copies (SOMs) This field indicates the number of copies (1-9) that should be printed for the selected SOMs. 
Search Results  

SOM Id This field identifies the system-generated number assigned to the SOM. 

Local Id This field identifies the system-generated number assigned to the SOM. 

Service Offering This field identifies the Service Offering (e.g. Lettermail) of the SOM. 

Mailed on Behalf of 
Customer Number 

This field identifies the CPC assigned customer number of the customer who owns the 
mailing (i.e., customer on behalf of whom the mailing is being prepared). 

Downstream Entry This field identifies that the mailing is downstream, allowing the customer to specify the 
Outlet, Date of Mailing and Shipment No. at the line item level. 

Outlet Name This field identifies the outlet name selected at the header level. It identifies where the mail is 
paid when Downstream Entry is selected. 
Otherwise, it identifies the outlet name where the mail is brought for induction into CPC’s mail 
stream. 

Method of Payment This field indicates the customer’s chosen method of payment for the mailing. 

Date/Time This field identifies the date and time the SOM was created. 

Mailing Date This field identifies the date when the mailing is to be inducted at Canada Post.  The Date of 
Mailing has an influence on the calculation rules. 

Total Volume This field identifies the Total Number of Pieces included in this SOM. 

Status This field identifies the Status of the SOM (e.g. Transmitted). 

Attempted 
Communication Date 

This Field identifies the date that the data was transferred to the CPC Server. 

Grand Total This field identifies the Total Cost associated with this SOM. 
Search Details  

Service Description This field identifies the service description chosen for the line item.  

No. of Pieces This field identifies the total number of pieces per specific line item, making up part or all of a 
mailing issue. 

Weight per Piece This field indicates the weight for a specific line item on the data entry form.  The Weight is 
necessary to calculate postage costs. 

Unit of Measure  This field indicates the unit of measurement (‘g’ or ‘kg’).  

Eligible for PAP This field identifies whether a specific line item is eligible for the DCH subsidy.  

Outlet This field identifies the outlet name where the SOM line item is brought for induction into the 
CPC’s mail stream. This field only applies when Downstream Entry is selected. 

Date of Mailing This field identifies the date when the SOM line item is to be inducted at Canada Post. This 
field only applies when Downstream Entry and/or Mailing Type Partial is selected. 

Calculated Metered Rate This field shows the rate that should be used to meter the mailing items. 

Price/Piece This field identifies the price of a piece of mail for the given line item. 

Price/kg ($) This field identifies the weight price associated the given line item. 

Transportation Required This field identifies whether a specific line item requires transportation. 

Transportation 
Price/Piece 

This field identifies the transportation price of a piece of mail for the given line item. 
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Postage This field identifies the total postage cost for the mail items of the given line item. 
 
Command Buttons  
 
The following table describes the Command Button definitions and displays the hot key definitions (by underlining the letter in 
question): 
 

COMMAND BUTTON 
OR MENU ITEM  

RESULT OF INVOCATION 

Search A query is generated based on the search criteria entered. 
If no transactions are found in the database that match the search criteria then a message is displayed. 
If more than 500 transactions are found, a warning message will be displayed. 
If one or more transactions are found they are listed in the data grid 
A warning message will be generated if the Start Mailing Date is greater than the End Mailing Date. 

Clear All search criteria fields; Search Results and Details tables are cleared, allowing a new search to be initiated. 

Open Opens the data entry window for the selected Order and populates the window with data located in the 
selected Order or template record. 
For a SOM with a status of transmitted, the following information is not retrieved from the saved SOM record. 

Issue Date (Publications Mail only) 
Mailing Date 

Preview When a SOM entry is selected, performs the same process as the Preview button. 

Finalize Performs the same process as the Finalize button on the main Desktop window. 

Transmit/Print Performs the same process as the Transmit/Print button on the Desktop window. 

Void Enabled when you have selected from the Details pane a single manifest entry with a status of ‘Opened’.  
Opens a confirmation window ‘Are you sure you want to void this line item?’ 
      If confirmed: Clears (i.e. sets to zero) the Quantity, Keyed and Calculated weight and all changes fields; 
Resets the Traceable and Notify Recipient indicators to false; Sets the item as ‘Void’ and closes the 
confirmation window. 
       If the action is cancelled, closes the confirmation. 

Reprint Performs the same process as the Reprint button on the desktop window. 

Close The Search window is closed and the Desktop window is displayed. 

8.2 Scale Configuration 
 
Access this window by selecting Scale Configuration from the Tools menu. 
 

 
 
Overview 
Use the Scale Configuration window to set up and default the scale you will be using with Electronic Shipping Tools, or to indicate 
that you will not be using a scale. 
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Electronic Shipping Tools supports three scale vendors: the Pitney Bowes scale, the Weightronix scale, and the Mettler scale. 
Select your scale type from the list, or select None/Aucune, then click OK.  
 
Once you have selected a specific scale, use the <scale name> Scale Configuration window to configure that scale.   
 
   
 

Scale Configuration 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Scale Selection List Electronic Shipping Tools supports three scales: the Pitney Bowes scale, the Weightronix scale and the 
Mettler scale. 
Select your scale type from the list, or select None/Aucune, then click OK.  If you selected one of the scales 
you will then have an opportunity to configure the scale more specifically using the Scale Configuration 
window 

OK Once you have selected a scale type, or have selected None, click OK.   
If you selected one of the scales you will have the opportunity to configure the scale more specifically. 

Cancel Click to close this window without changing your scale selection.  You are not prompted to configure a 
selected scale. 

8.3 Eltron/Zebra Custom EST Label Configuration 
From the Desktop Main Menu, select Tools, Eltron/Zebra Configuration to set-up an Eltron or a Zebra Thermal Printer; 
 

 
 
Overview 
Select the model of Eltron printer and from the drop-down list one of the pre-defined ports available on the workstation’s operating 
system and press OK to accept. 
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8.4 Printer Configuration 

Access this window by selecting Printer Configuration from the Tools menu. 
 
Overview 
Use the Printer Configuration window to set up your Windows printers to recognize and print the various types of labels and forms 
that are generated by Electronic Shipping Tools. In this window, you enter the name and type of your printer(s), and what kind of 
paper/label you'll be printing. 
 
The Printer Configuration option allows you to identify the printer (s) to be used with the application.  Printers can be added, 
deleted or modified within the user interface component.  For each printer, you can indicate the type (Laser, Dot Matrix or Thermal), 
the media (plain paper, Thermal paper or pre-printed Dot-Matrix forms).  From the Main Menu, select Tools > Printer Configuration. 
 
Custom Thermal Printers 
 
The Desktop version now supports all thermal printers defined by your computer’s operating system through your Windows drivers. 
 
You may select from the drop down list, a different thermal printer.  The most common ones are found under Thermal (Windows 
Driver), which does not include the integrated driver within the application, as per the Eltron models.  However, you will first need to 
install the appropriate printer-specific Windows driver on your workstation. 
 
Please Note:  If you encounter printer specific driver installation errors, please refer to your printer manual for assistance 
 
There is a close relationship between the printer and media type, and the labels that are printed on that media. For instance, a Laser 
printer will print only plain paper or Avery labels; a Thermal printer will print only on thermal paper; a Dot Matrix printer uses tractor-
fed plain paper, pre-printed labels, multi-part paper, and other types. This, of course, affects the type of labels you order and use, 
and Electronic Shipping Tools needs to know how you want your output to appear. 
 
This window is closely tied to the Output Configuration window, where you tell Electronic Shipping Tools more specifically how you 
would like the various kinds of output produced, based on your printer selections and configurations here. 
 
  
 

Printer Configuration 
COMPONENT DESCRIPTION 

Installed Printers A listing of all printers currently configured for this application. 

  Printer Alias An alternate name for the printer that is user defined.   
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  Printer Name The make and model of the printer generated from the list of printers installed through Windows. 

  Installed Media The media (paper) type that is currently associated with the printer. 

Printer Configuration The user input area to define the available printers. 

  Name The make and model of the printer.  The field will initially be populated with the Name of the Printer 
selected.  When adding a new printer, the field will be cleared and the drop-down will present the 
user with a choice of all Windows configured printers on their system.  This field is mandatory. 

  Type Type of printer selected and is used to validate the various media types to be used.  This field is 
populated with Type of the printer initially selected.  If configuring a new printer, this field will be 
cleared and the user will be given the choice of selecting one of three types: Dot Matrix, Laser or 
Thermal.   

  Port Port associated with selected printer.  When configuring a new printer, it will be automatically 
populated when the Printer Name is chosen. (Windows has already been configured with this 
information so this field is read only) 

  Media The media (paper) type that is currently associated with the printer.  This field is populated with 
Installed Media of the selected printer.  If configuring a new printer, this field will be cleared and 
the user will be given a choice of various media types based on the type of printer selected.  

  Alias An alternate name for the printer that is user definable.  Initially, this field is populated with the 
Alias of the selected printer.  The user can modify it.  If a new printer is being configured, once a 
Printer Name is selected, this Name automatically populates the Alias field but the user can 
change it immediately.   

 
Command Buttons  
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

New All fields in the Printer Configuration Group Box will be cleared and focus will be on the first Printer 
Name within the opened drop-down box.  Select a Printer. 

Delete If a printer is not selected, displays error message to inform you to select a printer to delete. 
If a printer is selected, displays warning message to confirm the deletion. 
If OK is pressed, deletes the printer currently selected.  
If Cancel is pressed, returns control to calling window. 

Save When one of the fields has been modified, select Save Printer Configuration.   
Information within the Installed Printers group Box is immediately updated. 

Close Close Printer Configuration Window. 
Return control to Main Menu. 

8.5 Output Configuration 
 
Access this window by selecting Output Configuration from the Tools menu. 
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Overview 
Use the Output Configuration window to specify, for each document and label type produced by Electronic Shipping Tools, the 
printer to use and the barcode type to expect. 
 
This configuration relies on the configuration performed in the Printer Configuration window. There is a close relationship 
between the printer and media type, and the labels, reports, and manifests that are printed on that media. 
 

Window Graphical Component Definitions 
 
The purpose of this section is to identify the labels for each window graphical component and to describe its functionality. 
 

Output Configuration 
COMPONENT DESCRIPTION 

Documents This list displays summary information about all currently configured document types. 
The first item in the list is highlighted when the window is opened. 

 Document Type The Document Type will be table driven from the local database and will display all Document 
Types within the application. 

 Printer The printer currently associated with the corresponding Document Type. 

 Barcode Type The Barcode Type currently associated with the corresponding Document Type. 

Document Printer and 
Barcode Type 

The user input area to associate the Printer and Barcode Type to the selected Document Type. 

 Document Type Displays the Document Type selected in the Documents Group Box. 

 Printer Initially, the Printer of the selected Document Type will be displayed.  The drop-down list will 
display a list of printers configured on your workstation.  If there is only one printer configured on 
the workstation, it should be defaulted for all Document Types.  If there is more than one printer 
configured, then blank should be defaulted.  Defaulting blank will help avoid the entry of an 
incorrect printer. 

 Media This field is for information purposes only and will display the Media currently associated with the 
selected Printer. (From Printer Configuration)  

 Barcode Type For Shipping and Delivery Services only.  A table driven field presenting the user with a list of 
barcode types available with the Document Type selected.  If there is no Printer selected, this field 
should remain blank. 

 
Command Buttons 
 
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Save When one of the fields has been modified, select Save to save your changes. 

Close Close the Output Configuration Window. 
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8.6 Proxy Server Configuration 
Access this window by selecting Proxy Server Configuration from the Tools menu. 

 

 
 
 
Overview 
 
The Proxy Server Configuration task allows you to manage the Proxy Server information.  You can modify Proxy Server data or 
select not to use a Proxy Server.  Selecting Proxy Server Configuration from the Tools menu accesses this window. 
 
If a Proxy Server is used, you will be required to enter the Proxy Server IP Address and Proxy Server Port.  Your Network 
Administrator will be able to assist you in this process.   
 
When you select Yes, you will be required to enter the IP address and port of you Proxy server (HTTP or Secure server).  In 
addition, your proxy server will require user identification by clicking on the Authentication button and entering a valid user id and 
password. 

 

 
 
 

Proxy Server Configuration 
Component Description 

Do you want to use a 
Proxy Server? 

This field indicates whether or not a Proxy Server will be used. 

Proxy Server IP 
Address (HTTP Proxy 
or Secure Proxy 
Server) 

This field records the IP Address of the Proxy Server for subsequent connections.  Numeric with IP 
Address Data Mask (i.e. xxx.xxx.xxx.xxx where there is a three character maximum between periods) 
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Proxy Server Port This field identifies the port number for the Proxy Server. 

 
Command Buttons 
 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Authentication Enabled when a proxy server is selected.  As part of the proxy server authentication, a valid user 
id and password must be entered. 

OK When one of the fields has been modified, select OK to save your changes. 

Close Close the Configure Proxy Server Window. 

8.7 Purging 
Access this window by selecting Purging from the Tools menu. 
 

 
 
Overview 
The Purging window allows you to archive older, historical data from the Electronic Shipping Tools database. This will reduce the 
size of the database, and may increase application performance. 
 
Purging means that data will no longer be available for reporting within the application.  To purge data, you must enter a date, which 
must be minimum of 60 days prior to the current date.   
 
You can specify if archiving is desired.  Archiving saves the purged records for reference purposes.  If you choose not to archive, 
the data purged will be completely lost. 
  
If requested, archived orders can be purged in the same file layouts as those produced during the Order History Export process.  An 
archive file can facilitate the creation of a separate database. 
 
Format for files the suffix used for the file names is Archive.  The transmission log files are comma-delimited files where files are all 
enclosed in double quotes (“”).  The application will store a blank entry (i.e. “”) where no information is available. 
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Name of file created: Transmit Log Archive.txt 
 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Transmission Log Transmission Log Id Transmission Log Id. 

Transmission Log Transmission Date Transmission Date. 

Transmit Order Message Order Id Order Id. 

Transmit Order Message Message Type Code Message Type Code. 

Transmit Order Message Diagnostic Transmission Message. 

Transmission Log Application Version Number Version Number of the application 
when transmission occurred. 

8.8 Order History Export 
Access this window by selecting Order History Export from the Tools menu. 
 

 
 
Overview 
You can export shipping information for integration into your own database for creating your own reports, or to facilitate electronic 
reconciliation. Exporting is accomplished using the Order History Export window. 
 
Enter a Start Date and an End Date for the exported information in the fields provided on the Order History Export window, then 
click OK. Electronic Shipping Tools will then prompt you for a name and location for the saved files using a standard Windows 
format. Follow the prompts to save your manifest, mailing items, and mailing item add-ons information.   
 
Format for files Order History Export files are comma-delimited files where fields are all enclosed in double quotes (“ ”).  The system 
will store a blank entry (i.e. “”) where no information is available. 
 
Note:  Field descriptions (such as Method of Payment Description) are in the language of the user that initiated the process. 
 
Exported files include: 
Shipping and Delivery Services: 
Manifests 
Manifest Items 
Mailing Item Add-ons 
Manifest Bulk Items 
 
If no Order of a given category (i.e. Manifest or SOM) matches the selection criteria, none of the files in that category are created. 
 
Upon validation of the date information, the Export Files Location window is displayed: 
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Export Files 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Save in Displays the location of the current folder in the hierarchy of folders on the computer. 

Up One Level Opens the folder on level higher than the current folder selected and refreshes the information in 
the list box. 

View Desktop Toggles the current folder from Desktop to My Computer. 

Create New Folder Creates a new folder under the current directory. 
Allows the user to name the directory. 

List Lists the name of the folders and files in the List Box. 

Details Lists the details of the folders and files in the List Box. 

Files Suffix Provides a space for you to enter a suffix that will be appended to the name of files (see Order 
History Export Files section for details).  Defaults to Current Date in yyyymmdd format. 

Save as type Specifies the extension of the files be saved.  Defaults to ‘Text (*.txt)’. 

Save Performs validations and saves file. 

Cancel  Closes the window  
 
Order History Export File Layouts 
The Order History export files are comma-delimited files where fields are all enclosed in double quotes (‘”).  The system will store a 
blank entry (i.e. “”) where no information is available.   
 
 
 
 

8.9 Barcode Ranges 
 
Access this window by selecting Barcode Ranges from the Tools menu. 
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Overview 
Use the Barcode Range Maintenance window to enter a range of item identifiers associated with barcodes used on pre-printed 
labels.  Centrally managed barcode ranges must be activated through this screen.  This window also allows for the management of 
application-generated barcodes. 
 
The Barcode Ranges frame displays a list of Canada Post Shipping and Delivery Services products, and the ranges of item 
identifiers currently assigned to the product. To assign a range of item identifiers to a product, click the product name in the Barcode 
Range Name column, complete the fields in the Barcode Range Values frame, then click Save. 
 
The Frequency field allows you to modify the frequency a range is refreshed.  Shippers who use hundreds of barcodes daily will be 
prompted to reconnect when the ranges are depleted during the shipping process. 
 
 
 

Barcode Range Maintenance 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Barcode Range Name This frame displays a list of Canada Post Shipping and Delivery Services products, and the 
ranges of item identifiers currently assigned to the product. To assign a range of item identifiers 
to a product, click the product name in the Barcode Range Name column; complete the fields in 
the Barcode Range Values frame, then click Save. 

Start Enter the item identifier (barcode number) that starts the range of labels provided to you. The 
format for a complete item identifier is AA ### ### ### AA (a two-letter prefix, a nine-digit 
number, and a two-letter suffix). 

End Enter the item identifier (barcode number) that ends the range of labels provided to you. The 
format for a complete item identifier is AA ### ### ### AA (a two-letter prefix, a nine-digit 
number, and a two-letter suffix). 

Next Available Enter the nine digits that make up the numeric portion of the item identifier (barcode number) that 
is next to be used in the range of labels provided to you. If you are entering a new range of 
labels, this is the first label in the range. The format for a complete item identifier is AA ### ### 
### AA (a two-letter prefix, a nine-digit number, and a two-letter suffix). 

Frequency If you use a thermal printer, in this field, enter the number of item identifiers to be downloaded 
from the Canada Post server. See the Barcode Management topic for more information. 

Clear Click Clear to erase the current values in the Barcode Range Values fields without saving. 

Save Click Save to save the current values in the Barcode Range Values fields. 

Close Closes the window 
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8.10 Reserve SOM Ids for Presort Software 
 
Access this option by selecting Reserve SOM Ids for Presort Software from the Tools menu (for Communication Business only). 
 

 
 
Overview 
Reserve SOM Ids for Presort Software allows you to select one or more SOM Ids for use by Recognized SERP* Presortation 
Software with Barcode Recognition. Once you export or print the SOM Ids, the status will be updated from "Reserved" to "Assigned 
for SERP*". 

8.11 Check for Application Data and Barcode Update 
 
Access this option by selecting Check for Application, Data and Barcode Update from the Tools menu. 
 

 
 
Overview 
When selecting this option from the Tools menu, the CPC server first verifies that your installed version of the application is current.  
If the update exists on the CPC server, the update can occur automatically or in some cases, an update may be deferred for a later 
time.  In any case, you will be prompted to restart the application following the update process. 
 
If you are part of a Multi-user environment, a warning message will be displayed indicating that all users should sign out of the 
application until the update process is complete.   
 

 
Overview 
Use the Check for Application, Data and Barcode Update option to connect immediately to Canada Post to download data to your 
desktop application. Key in your User ID and Password, then click OK to proceed. Click Cancel to abort the connection procedure. 
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8.12 Sign In Electronic Shipping Tools  
Access this window by selecting Sign In Electronic Shipping Tools from the Tools menu. 
 

 
 
Overview 
The Sign In Electronic Shipping Tools window enables you to logon to the Electronic Shipping Tools application as well as to 
change your password.   
 
The Sign In Electronic Shipping Tools window is available only when Security Enabled is selected in the Options tab in the Site 
Information window.  When Security is enabled, the administrator may have identified specific functions for specific users, thus 
restricting Sign On access through the main menu drop downs.  If the Sign In window is displayed when you double click the 
application ID, you will be required to enter a User ID and password, otherwise you can start to use the application right away. 
 
You can sign in to the Electronic Shipping Tools two ways: 
 
Double click on the Electronic Shipping Tools application icon, which will launch the application and present the Sign In Electronic 
Shipping Tools window or select Sign In Electronic Shipping Tools from the Tools main menu in Electronic Shipping Tools to sign in 
a new user. 
 
Enter a valid User Id and Password in the pop-up window, then click OK or press Enter.   
 
Note: The system will remember the User ID between sessions if the Remember User Id checkbox is checked.  If you don't know 
your User ID or Password, contact your system administrator. If you still can't get them, contact the Help Desk. 
 
The initial Sign In will be dropped after a pre-determined period of inactivity, so if you are creating a manifest in the disconnected 
state, you will need to reconnect when you’re ready to transmit.  The Sign In screen will facilitate the Sign On activity, where in most 
screens, the Sign On screen is initiated through command button invocations such as Transmit/Print. 
 

Sign In 
 USER ACTIONS USER INTERFACE 

Sign In (from application icon 
on Windows desktop) 

Double click on the 
application icon, which is 
located on the computer 
screen desktop. 

Enter valid User Id and Password to access the application. 
Note: User Id is not required each time as the system can 
remember it between sessions. 

Sign In (from Tools menu) Select Sign In sub-menu 
item from the Tools main 
menu. 

Enter a valid User Id and Password to access the application. 

Change Password Click on the Change 
Password Command Button 
on the Sign In window. 

Enter your old password, along with a new password 

 
 
 
 
Access this window by selecting Sign In Electronic Shipping Tools from the Tools main menu, then clicking the Change 
Password command button, which opens the Change Password window (below). 
 

Change Password 
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User Ids and passwords are alphanumeric with a maximum length of 8 characters.  Selecting the Remember User Id box will result 
in your User Id being displayed in the field the next time you are presented this Sign In screen.  
 
 If you select the Change Password button, a dialog box is presented (above).  . Enter your old password, along with the new 
password in the New Password and Confirm Password fields.  Select Ok after you have changed your password.   

8.13 Sign Out Electronic Shipping Tools 
Access this window by selecting Sign Out Electronic Shipping Tools from the Tools menu 
 

 
. 
Overview 
The Sign Out Electronic Shipping Tools window allows you to sign out of Electronic Shipping Tools.  Signing out will disconnect 
you from the Electronic Shipping Tools server, if a connection exists and will log off the current user.  
 
The Sign Out Electronic Shipping Tools window is available only when Security Enabled is selected in the Options tab in the 
Site Information window. 
 
Selecting Exit from the File menu will automatically close down the application completely, whereas if Sign Out Electronic 
Shipping Tools is selected from the Tools menu, a pop-up window will display to confirm if you want to sign out of Electronic 
Shipping Tools.  If you select Yes, your User ID will be logged off and you’ll be returned to the main menu of the application.  If you 
select No, the pop-up window will be closed and you’ll be returned to the previous window. 
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9.0 Window Menu 
Overview 
Use the Window menu to select from the open windows on the Electronic Shipping Tools application. 
 

10.0 Help Menu 
 
Use the Help menu to access tools you need to complete the order. 
 
You can open EST messages from Help on the Navigation bar.  
 
You can open the Help menu by clicking on the Help button on the Navigation bar 
 

 
 
If you click on the Command button – Help, this sub-menu will appear: 

 

 Click Help 
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10.1 EST News 
Select EST News to view contents of the upcoming changes and notices for outages 

 

10.2 Release Notes 
Select Release Notes to view contents of Current and Past Release Notes 
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10.3 Electronic Shipping Tools 
Select Electronic Shipping Tools to access directly to the User Guides and reference material  

 

10.4 Help 
Select Help to access the Electronic Shipping Tools Online Help  
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10.5 HouseHolder Counts & Maps 
Select HouseHolder Counts & Maps to access information on the Address Management Tools for the Canada Post Help Desk. 

 

10.6 Track a Package 
Select Track a Package to access information from the Web site to track your package 
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10.7 Products & Services 
Select Product & Services to access information about Canada Post products & services directly from the Canada Post web site. 

 

Contacting the Help Desk 

If you have set-up or technical questions that can't be answered using this help, contact the Help Desk weekdays from 7:00 am to 
9:00 pm (Eastern Standard Time) at 1-800-277-4799. 

If you need supplies, contact the Distribution Centre weekdays from 8:00 am to 6:00 pm (Eastern Standard Time) at 1-888-550-
6333. 

10.8 Help Desk Tickets 
When you encounter a System error and the problem persists, you must select the Copy Logs button to create a copy of the log 
files that will be required by the Help Desk. 

 
When you select the Copy Logs button, the following logs are copied under the VCD installation folder: 
 

o stderr.txt 
o stdout.txt 
o \bin\upgrades.log 
o \bin\desktop.properties 
o \bin\synchronization.log 
o \download\data.zip 

 
The folder is created if it does not exist, or will be overridden if any log is in the folder.  The copied logs are deleted if you upload a 
Help Desk Ticket. 
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Once this folder is created, you are ready to contact the Help Desk to open a ticket. 
 
You now  have the ability to send an email to the Technical Help Desk from the Desktop application, either related to an OPEN 
ticket (previously provided by the Help Desk), or requesting the DELETION of a transmitted SOM (directly from the application). 
 
Clicking on a sub-menu, gives you the ability to: 
 

- Create a NEW request 
-       Browse previous ones  
- Click on Help 
- Select Help Desk Tickets 
- Call the Help Desk to have a ticket number issued 
- Enter this number in the Help Desk Ticket request 
- Complete the mandatory fields, and provide any necessary additional information 
- eMail your request to the Help Desk 

 

 

10.9 SOM Deletion Request (Communications Orders only) 
 

o Click on Help 
o Select SOM Deletion Requests 
o Enter the SOM ID # 
o Click on the Search button 
o Complete the mandatory fields, and provide any necessary additional information 
o eMail your request to the Help Desk 

 

 
 
A successfully transmitted email will display the details in the bottom section in read-only mode.  With a new request, the details 
section is blank, allowing you to add further information about the request. 
 
NOTE:  While you are composing and sending a request to the Help Desk, the application will not be available for shipping or 
mailing.   
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Any orders that were finalized and ready to be transmitted will be sent separately. 

10.10     About 
 
To access this window, select About in the Help menu 
 

 
 
Overview 
Select About in the Help menu for information regarding the version of Electronic Shipping Tools. 

 

11.0 Manifest Management 
Every shipment processed through Electronic Shipping Tools must be associated with a manifest.  A manifest collects detailed 
information about each shipment, including billing information.  Manifests are created by Mailed On Behalf Of Customer Number 
(i.e. you can have the same manifest type open for different customer numbers), Service Type (e.g.  Purolator International belongs 
to the International Courier manifest type and Priority Courier Piece Rated belongs to the Priority Courier manifest type), and 
Method of Payment (e.g.  for one customer number, you can have a manifest type open for Account and the same type open for 
Credit Card). 
 
Generally, you do not need to worry about creating manifests for your shipments.  When you select the Service Type for your 
shipment on the Service tab of the Shipping window, Electronic Shipping Tools checks to see if a manifest is already open for the 
specified Service Type.  If there is an existing one, the Manifest field becomes populated with the manifest name (i.e.  date and 
time of creation), along with its Local ID.  If there is not already one open, the application automatically creates and opens one for 
the chosen Service Type when you click Process/Print. 

11.1 Transmitting/Printing Manifest 
 
When you are finally ready to ship your items, you need to Transmit/Print the associated manifest.  If you need to include any 
prepaid items, access the Manifest window to enter this data.  If not, just click on the line item representing the desired manifest on 
either the Application Desktop window or Search/Manage Orders window and click Transmit/Print.  This initiates a connection to 
the CPC server, and the manifest information is sent. 
 
ATTENTION!  Remember to include the printed copy of the manifest with your shipment, so that the inclusions can be identified by 
the Canada Post agent at pick-up (or when you drop it off at a Canada Post location).  Otherwise your shipment will be rejected.  A 
printed copy of the manifest preview is unacceptable. 
 
If the transmission fails, the application prints a manifest with a “Non-Transmitted” watermark on each page.  Attach this printed 
copy to your shipment and retransmit the manifest later. 

11.2 Creating Your Own Manifest 
 
You may need to create your own manifest sometimes.  For example, you may want to create two manifests for the same Service 
Type, with the intent of using one of the manifests for shipments to be sent today and the other to enter shipments that will not be 
sent until the end of the week.  When you enter shipments using this Service Type, the Manifest field on the Ship tab becomes a 
drop-down list with all the available open manifests for that Service Type.  Be certain to assign the shipments to the correct 
manifest.  In the Manifest window, you can assign aliases (i.e.  meaningful names) to the manifest for ease of reference. 
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Manifest Window 
 

 
 
• Access this window by 

1. selecting New Manifest from the File menu; 
2. double-clicking on a manifest line item on the Application Desktop window; 
3. clicking on the line item and selecting Open from the File menu or clicking the Open button at the bottom of the 

Application Desktop window, or; 
4. clicking on a manifest line item in the Search Results frame of the Search/Manage Orders window and clicking Open. 

 
Use the Manifest window to create a new manifest, or to edit an existing manifest. 
 
Command Buttons 
 
 
 
Click this button to save the current manifest information.  The window is not closed and the current data remains in case more 
changes need to be made. 
 
 
 
 
For the preview functionality to work, the manifest must have at least one open item (i.e.  not voided) attached to it.  Click this button 
to preview the current manifest.  The Reports window appears with the heading “Manifest Preview” along with the current date.  
You can print the manifest preview. 
 
 
 
Click this button to exit the Manifest window.  If you have entered new data or made changes to existing data, a Yes/No/Cancel 
confirmation pop-up window appears asking you if you want to save your changes. 
 
ATTENTION!  Even though the Outlet field is not marked with an asterisk to indicate that it is mandatory, it is a required value.  

Validation occurs when you click the Save button. 
 

Manifest Window 
FIELD NAME (* = mandatory) FIELD CHARACTERISTICS 

Mailed By (Customer Number) This numeric field is display-only and cannot be altered by the user.  It identifies the 
Canada Post-assigned customer number of the customer that is preparing the 
mailing.  It is the customer number associated with the login User ID. 

Mailed On Behalf Of (Customer Number) * Select from the drop-down list the number of the owner of the mail, even if it is the 
same as the Mailed By customer number.  This numeric field identifies the Canada 
Post-assigned customer number of the customer who owns the mailing (i.e.  
customer on behalf of whom the mailing is being prepared).  When the drop-down 
list is open, the corresponding customer names are also displayed. 
 

Save 

Preview 

Close 
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Note:  Once items are assigned to a manifest (even if they are voided), the Mailed 
On Behalf Of customer number and Contract number cannot be modified as it may 
affect the validity of some of the items on the manifest. 

Contract * The drop-down list becomes populated with contract numbers, along with any 
aliases, associated to the chosen Mailed On Behalf Of customer number.  Select the 
appropriate contract from the list. 
 
Refer to note for Mailed On Behalf Of customer number. 

Paid By Customer * The drop-down list becomes populated with customer numbers, along with the 
customer names, that are valid payer partners of the chosen Mailed On Behalf Of 
customer number.  This numeric field identifies the customer number of the customer 
who will be paying for the mailing.  Select the desired customer number from the list. 

Shipper Reference Number Enter any reference number or code that you want to use to identify the shipment.  
Maximum of 15 characters. 

Method of Payment * Select from the drop-down list the method of payment for the transaction.  Options 
are Account, Credit Card, and Metered.  This field is defaulted to the preferred 
Method of Payment associated with the Paid By Customer, if any. 
 
Note:  Credit Card appears only if there is a contract chosen.  Furthermore, if Credit 
Card is selected, the transaction will be processed ONLY IF the Mailed By and Paid 
By customer numbers are the same. 

Selected Credit Card This field becomes enabled when Credit Card is selected as the Method of Payment.  
Select from a drop-down list of existing credit card aliases (if any were previously set 
up), or choose Other to enter credit card information for one-time use (i.e.  an alias is 
not created for later use).  If Other is chosen, the Credit Card Data Entry window 
appears. 

Outlet * Select from the drop-down list the outlet to which mail is to be brought for induction 
into CPC’s mail stream. 
 
If you are viewing an existing manifest with attached items (even if all are voided), 
this field is display-only. 
 
To add an outlet to the list of available choices, select Site Information from the Data 
Maintenance menu.  Go to the Induction Point tab. 

Manifest Name * Enter a name for the manifest. 
Manifest Type * The drop-down list becomes populated with Manifest types associated to the 

selected Contract.  Choose the desired type to identify the Manifest bundle. 
 
If you are viewing an existing manifest with attached items (even if all are voided), 
this field is display-only. 

Total Prepaid Enter the number of shipment items that have been prepaid. 
Destination PC Enter the destination Postal Code for Commercial Air Stage Freight.  This field is 

disabled for the other Service Types. 
On Demand Pickup Select this checkbox if you will call Canada Post for a pick up of your Priority Courier 

items.  The appropriate charge is added to the manifest. 
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Appendix A 
LABELS FOR SHIPPING AND DELIVERY SERVICES 
Consult the following tables for an overall view of the Address labels and Printing format available. 
It may vary with the Printer configuration, the destination of the shipment, and/or the service used. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Service (English / Francais) Labels/Etiquettes Indicator/Indicateur

Purolator International Courier 
PuroLetter 
PuroPak 

Purolator Bill of Lading Plain Paper/ 
Connaissement Papier 

                    None

USA Small Packets Air/ 
Petits paquets par avion 

International Small Packets Air 

Plain Paper/Papier
Thermal/Thermique 

                    None

USA Small Packets Surface 
/Petits paquets surface 

International Small Packets Surface 

Plain Paper/Papier
Thermal/Thermique 

                    None

International Parcel Air/ Par avion Plain Paper/Papier
Thermal/Thermique

                    None

International Parcel Surface/ Surface Plain Paper/Papier
Thermal/Thermique 

                    None

Commercial Expedited Parcel- USA/ 
Commercial  accélérés É.-U. 

Plain Paper/Papier
Thermal/Thermique 

                      4 

Expedited Parcel – USA/ 
Colis accéléré É.-U 

Plain Paper
Thermal/Thermique

                      2 

Xpresspost USA/ Xpresspost É.-U. 
Xpresspost USA Prepaid 

Plain Paper/Papier
Thermal/Thermique 

Pre Printed/Pré imprimé

                      1 

Xpresspost International/ 
Xpresspost International 

Plain Paper/Papier 
Thermal/Thermique 

                      1 
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Service (English / Francais) Labels/Etiquettes Indicator/Indicateur

Regular Parcel Piece Rated/ Colis régulier 
Regular Parcel Piece/Kilo 

Flat Rate Regular 

Plain Paper/Papier
Thermal/Thermique 

Pre-Printed/Pré-imprimé 
CODThermal/CR thermique

                          3

 
Expedited Parcel Piece Rated/ 

Colis accéléré 
Expedited Parcel Piece/Kilo 
Expedited Parcel Flat Rate

Plain Paper
Thermal/Thermique 

Pre-Printed/Pré-imprimé 
COD Thermal/CR thermique

2

Xpresspost Piece Rated/ Xpresspost 
Xpresspost Flat Rate 

Xpresspost PP Induction 

Plain Paper
Thermal/Thermique 

Pre-Printed/Pré-imprimé 
COD Thermal/CR thermique

1

Air Stage Freight Nutritious Perishable/  
Aliments nutritifs périssables 

Plain Paper/Papier
Thermal/Thermique 

Pre-Printed/Pré-imprimé 

None

Air Stage Freight Other Food/ 
Omnibus autres aliments 

Paper/Papier
Thermal/Thermique 

Pre-Printed/Pré-imprimé 

None

Air Stage Freight Non Food Items/  
Omnibus articles non aliments 

Domestic Paper/Papier
Thermal/Thermique 

Pre-Printed/Pré-imprimé 

None

Priority Courier Piece Rated 
/ Messageries prioritaires 
Priority Courier Flat Rate 

Priority Courier PP Induction

Plain Paper
Thermal/Thermique 

Pre-Printed/Pré-imprimé 
COD Thermal/CR thermique

P


